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Thank you for purchasing the ECO2 Series Digital Video Surveillance Recorder.

This manual refers to the following models:

• LH134 (4-channel)

• LH138 (8-channel)

• LH136 (16-channel)


For the latest online manual, downloads and product updates, and to learn about our 
complete line of accessory products, please visit our website at:

www.lorextechnology.com

CAUTION  

RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RICK OF ELECTRIC SHOCK DO NOT 
REMOVE COVER. NO USER SERVICABLE PARTS INSIDE.

REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral 
triangle, is intended to alert the user to the presence of uninsulated 
"dangerous voltage" within the products ' enclosure that may be of 
sufficient magnitude to constitute a risk of electric shock.
The exclamation point within an equilateral triangle is intended to 
alert the user to the presence of important operating and 
maintenance (servicing) instructions in the literature accompanying 
the appliance.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT 
EXPOSE THIS UNIT TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE 
OF THE PLUG TO THE WIDE SLOT AND FULLY INSERT.

http://www.lorextechnology.com


NEED HELP?
CONTACT US FIRST

2 Easy Ways to Contact Us

Please make sure to register your product at www.lorextechnology.com
to receive product updates and technical support.

DO NOT RETURN THIS PRODUCT TO THE STORE

SEP 12 2012 -  R14

North America:
Customer Service (for warranty matters): 1-888-425-6739 (1-888-42-LOREX)

Tech Support (for technical/installation issues): 1-877-755-6739 (1-877-75-LOREX)

Mexico: 001-800-681-9263, 001-800-514-6739

International:  +800-425-6739-0 (Example: From the UK, dial 00 instead of +)

By Phone:

Online:

For all other matters, visit www.lorextechnology.com

Product Support is available 24/7 including product information, user 
manuals, quick start up guides and FAQ’s at 
www.lorextechnology.com/support
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¿NECESITA AYUDA?
COMUNÍQUESE PRIMERO 
CON NOSOTROS

BESOIN D’ASSISTANCE?
COMMUNIQUEZ D’ABORD 
AVEC NOUS 

2 façons simples de communiquer 
avec nous : 

En Amérique du Nord :
Service à la clientèle (pour tout ce qui concerne la garantie) : 
1-888-425-6739 (1-888-42-LOREX)
Soutien technique (pour les questions d’ordre technique ou relatives à 

l’installation) : 1-877-755-6739 (1-877-75-LOREX)

Mexique : 001-800-681-9263, 001-800-514-6739

International : +800-425-6739-0

(par exemple : à partir du Royaume-Uni, composez le 00 au lieu de +)

Par téléphone :

Veuillez enregistrer votre produit sur le site 
www.lorextechnology.com afin de recevoir des mises à jour 
et le soutien technique pour votre produit.

Pour toutes les autres questions, 
visitez www.lorextechnology.com

À votre disposition 24/7, le soutien pour les produits comprend 
les renseignements sur les produits, guides d’utilisation, guides 
de départ rapide et FAQ :
www.lorextechnology.com/support

En ligne :

Hay 2 maneras fáciles de comunicarse 
con nosotros:

Norte América:
Atención al cliente (para asuntos de la garantía): 
1-888-425-6739 (1-888-42-LOREX)
Asistencia técnica (para asuntos técnicos o de instalación): 
1-877-755-6739 (1-877-75-LOREX)

Mexico: 001-800-681-9263, 001-800-514-6739

Internacional: +800-425-6739-0

(Ejemplo: Desde el Reino Unido, marque el 00 en lugar del +)

Por teléfono:

Apoyo al cliente está disponible 24/7, incluyendo 
información del producto, manuales para el usuario, guías 
de inicio rápido y preguntas más frecuentes en: 
www.lorextechnology.com/support

En línea:

Por favor, registre su producto en www.lorextechnology.
com para recibir actualizaciones del producto y 
asistencia técnica. 

Para todo lo demás, visite
www.lorextechnology.com

NO DEVUELVA ESTE PRODUCTO A LA TIENDA NE RETOURNEZ PAS CE PRODUIT AU MAGASIN

VIEW YOUR WORLD™
VOIR VOTRE MONDEMD

VEA SU MUNDO™



SEP 6 2012 -  R8

LOREX IS COMMITTED TO FULFILLING YOUR SECURITY NEEDS

• We have developed user friendly products and documentation.

   Please read the Quick Start Guide and User Manual before you 

   install this product.

• Consumer Guides and Video Tutorials are available on our web

   site at www.lorextechnology.com/support

• If you require further installation assistance, please visit 

   www.lorextechnology.com/installation or contact a 

   professional installer. 

• Please note that once the components of this product have been 

   unsealed, you cannot return this product directly to the store 

   without the original packaging.

THIS PRODUCT MAY REQUIRE PROFESSIONAL INSTALLATION

BEFORE YOU START
Please make sure to register your product at www.lorextechnology.com 

to receive product updates and technical support
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LOREX SE COMPROMETE A SATISFACER 
SUS NECESIDADES EN SEGURIDAD

LOREX S’ENGAGE À RÉPONDRE À VOS 
BESOINS EN MATIÈRE DE SÉCURITÉ

ESTE PRODUCTO PUEDE EXIGIR UNA IN-
STALACIÓN PROFESIONAL

CE PRODUIT PEUT NÉCESSITER UNE 
INSTALLATION PROFESSIONNELLE

• Nous avons conçu et développé une documentation
   et des produits extrêmement conviviaux. Veuillez 
   lire le Guide de départ rapide et le Guide 
   d’utilisation avant d’installer ce produit.

• Des guides pour consommateurs et des tutoriels 
   vidéo vous sont offerts sur notre site Web : 
   www.lorextechnology.com/support

• Si vous avez besoin de plus d’assistance pour
   l’installation de ce produit, veuillez visiter le site 
   www.lorextechnology/installation ou communiquez
   avec un installateur professionnel.

• Veuillez prendre note que lorsque vous avez déballé
   les pièces et composantes de ce produit, vous ne 
   pouvez pas retourner celui-ci directement au 
   magasin sans son emballage original.

• Favor de leer la guía de instalación rápida y la
   guía del usuario antes de instalar este product.

• Puede conseguir las guías del consumidor y los
   cursos en enseñanza video sobre el Internet 
   visitando www.lorextechnology.com/support

• Si necesita ayuda para la instalación, visite
   www.lorextechnology.com/installation o contacte 
   un especialista en instalaciones.

• Favor de notar que una vez que los componentes 
   de este producto han sido removidos del 
   embalaje, no podrá devolver este producto 
   directamente a la tienda.

AVANT DE 
COMMENCER

ANTES DE 
EMPEZAR

www.lorextechnology.com

Veuillez enregistrer votre produit sur le site 
www.lorextechnology.com afin de recevoir 
des mises à jour et le soutien technique pour 
votre produit.

Cerciórese de por favor colocar su producto 
en www.lorextechnology.com para recibir 
actualizaciones y la información del producto 
y soporte técnico.

VIEW YOUR WORLD™
VOIR VOTRE MONDEMD

VEA SU MUNDO™



Important Safeguards
In addition to the careful attention devoted to quality standards in the manufacture process of your 
product, safety is a major factor in the design of every instrument. However, safety is your 
responsibility too. This sheet lists important information that will help to ensure your enjoyment 
and proper use of the product and accessory equipment. Please read them carefully before 
operating and using your product.

General Precautions
1. All warnings and instructions in this manual should be followed.
2. Remove the plug from the outlet before cleaning. Do not use liquid aerosol detergents. Use a 

water-dampened cloth for cleaning.
3. Do not use this product in humid or wet places.
4. Keep enough space around the product for ventilation. Slots and openings in the storage 

cabinet should not be blocked.
5. It is highly recommended to connect the product to a surge protector to protect from damage 

caused by electrical surges. It is also recommended to connect the product to an 
uninterruptible power supply (UPS), which has an internal battery that will keep the product 
running in the event of a power outage.
Installation
1. Read and Follow Instructions - All the safety and 

operating instructions should be read before the product 
is operated. Follow all operating instructions.

2. Retain Instructions - The safety and operating 
instructions should be retained for future reference.

3. Heed Warnings - Comply with all warnings on the 
product and in the operating instructions.

4. Polarization - Do not defeat the safety 
purpose of the polarized or 
grounding-type plug.

A polarized plug has two blades with 
one wider than the other.

A grounding type plug has two blades 
and a third grounding prong.

The wide blade or the third prong are 
provided for your safety.

If the provided plug does not fit into your outlet, consult 
an electrician for replacement of the obsolete outlet.

5. Power Sources - This product should be operated only 
from the type of power source indicated on the marking 
label. If you are not sure of the type of power supplied 
to your location, consult your video dealer or local power 
company. For products intended to operate from battery 
power, or other sources, refer to the operating 
instructions.

6. Overloading - Do not overload wall outlets or 
extension cords as this can result in the risk of fire or 
electric shock. Overloaded AC outlets, extension 
cords, frayed power cords, damaged or cracked wire 
insulation, and broken plugs are dangerous. They may 
result in a shock or fire hazard. Periodically examine 
the cord, and if its appearance indicates damage or 
deteriorated insulation, have it replaced by your 
service technician.

7. Power-Cord Protection - Power supply cords should 
be routed so that they are not likely to be walked on or 
pinched by items placed upon or against them. Pay 
particular attention to cords at plugs, convenience 
receptacles, and the point where they exit from the 
product.

8. Surge Protectors - It is highly recommended that the 
product be connected to a surge protector. Doing so 
will protect the product from damage caused by power 
surges. Surge protectors should bear the UL listing 
mark or CSA certification mark.

9. Uninterruptible Power Supplies (UPS) - Because 
this product is designed for continuous, 
24/7 operation, it is recommended that you connect 
the product to an uninterruptible power supply. An 
uninterruptible power supply has an internal battery 
that will keep the product running in the event of a 
power outage. Uninterruptible power supplies should 
bear the UL listing mark or CSA certification mark.

Caution: Maintain electrical safety. Power line 
operated equipment or accessories connected to this 
product should bear the UL listing mark or CSA 
certification mark on the accessory itself and should 
not be modified so as to defeat the safety features. This 
will help avoid any potential hazard from electrical 
shock or fire. If in doubt, contact qualified service 
personnel.
v
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Installation (Continued)
10. Ventilation - Slots and openings in the case are 

provided for ventilation to ensure reliable operation of 
the product and to protect it from overheating. These 
openings must not be blocked or covered. The 
openings should never be blocked by placing the 
product on a bed, sofa, rug, or other similar surface. 
This product should never be placed near or over a 
radiator or heat register. This product should not be 
placed in a built-in installation such as a bookcase or 
rack unless proper ventilation is provided and the 
product manufacturer’s instructions have been 
followed.

11. Attachments - Do not use attachments unless 
recommended by the product manufacturer as they 
may cause a hazard.

12. Water and Moisture - Do not use this product near 
water — for example, near a bath tub, wash bowl, 
kitchen sink or laundry tub, in a wet basement, near a 
swimming pool and the like. 

13. Heat - The product should be situated away from heat 
sources such as radiators, heat registers, stoves, or 
other products (including amplifiers) that produce 
heat.

14. Accessories - Do not place this 
product on an unstable cart, 
stand, tripod, or table. The product 
may fall, causing serious damage 
to the product. Use this product 
only with a cart, stand, tripod, 
bracket, or table recommended by 
the manufacturer or sold with the 
product. Any mounting of the 
product should follow the manufacturer’s instructions 
and use a mounting accessory recommended by the 
manufacturer.

15. Camera Extension Cables – Check the rating of 
your extension cable(s) to verify compliance with your 
local authority regulations prior to installation.

16. Mounting - The cameras provided with this system 
should be mounted only as instructed in this guide or 
the instructions that came with your cameras, using 
the provided mounting brackets.

17. Camera Installation- Cameras are not intended for 
submersion in water. Not all cameras can be installed 
outdoors. Check your camera environmental rating to 
confirm if they can be installed outdoors. When 
installing cameras outdoors, installation in a sheltered 
area is required. 

Service
1. Servicing - Do not attempt to service this product 

yourself, as opening or removing covers may expose 
you to dangerous voltage or other hazards. Refer all 
servicing to qualified service personnel.

2. Conditions Requiring Service - Unplug this product 
from the wall outlet and refer servicing to qualified 
service personnel under the following conditions:

A. When the power supply cord or plug is damaged.

B. If liquid has been spilled or objects have fallen into 
the product.

C. If the product has been exposed to rain or water.

D. If the product has been dropped or the cabinet has 
been damaged.

E. If the product does not operate normally by 
following the operating instructions. Adjust only those 
controls that are covered by the operating 
instructions. Improper adjustment of other controls 
may result in damage and will often require extensive 
work by a qualified technician to restore the product 
to its normal operation.

F. When the product exhibits a distinct change in 
performance. This indicates a need for service.

7. Replacement Parts - When replacement parts are 
required, have the service technician verify that the 
replacements used have the same safety 
characteristics as the original parts. Use of 
replacements specified by the product manufacturer 
can prevent fire, electric shock, or other hazards.

8. Safety Check - Upon completion of any service or 
repairs to this product, ask the service technician to 
perform safety checks recommended by the 
manufacturer to determine that the product is in safe 
operating condition.

Use
1. Cleaning - Unplug the product from the wall outlet 

before cleaning. Do not use liquid cleaners or aerosol 
cleaners. Use a damp cloth for cleaning.

2. Product and Cart Combination - When product is 
installed on a cart, product and cart combination 
should be moved with care. Quick stops, excessive 
force, and uneven surfaces may cause the product and 
cart combination to overturn.

3. Object and Liquid Entry - Never push objects of any 
kind into this product through openings as they may 
touch dangerous voltage points or “short-out” parts 
that could result in a fire or electric shock. Never spill 
liquid of any kind on the product.

4. Lightning - For added protection of this product 
during a lightning storm, or when it is left unattended 
and unused for long periods of time, unplug it from 
the wall outlet and disconnect the antenna or cable 
system. This will prevent damage to the product due 
to lightning and power line surges.



This product has been certified and found to comply with the limits regulated by FCC, EMC, and 
LVD. Therefore, it is designated to provide reasonable protection against interference and will not 
cause interference with other appliance usage.

However, it is imperative that the user follows the guidelines in this manual to avoid improper 
usage, which may result in damage to the product, electrical shock and fire hazard injury.

In order to improve the features, functions, and quality of this product, the specifications are 
subject to change without notice from time to time.

NOTICES
FCC/IC Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction, may cause harmful interference 
to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception (which can be determined by 
turning the equipment on and off), the user is encouraged to try to correct the interference by one or more 
of the following measures:

• Reorient or relocate the receiving antenna
• Increase the separation between the equipment and receiver
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected
• Consult the dealer or an experienced radio or television technician for assistance

Modification:
Any changes or modifications not expressly approved by the grantee of this device could void the user's 
authority to operate the device.

Toute modification non approuvée explicitement par le fournisseur de licence de l'appareil peut entraîner 
l'annulation du droit de l'utilsateur à utiliser l'appareil.

RoHS:
This product is fully compliant with the European Union Restriction of the Use of Certain Hazardous 
Substances in Electrical and Electronic Equipment ("RoHS") Directive (2002/95/EC). The RoHS directive 
prohibits the sale of electronic equipment containing certain hazardous substances such as lead, 
cadmium, mercury, and hexavalent chromium, PBB, and PBDE in the European Union.

www.lorextechnology.com

Product Information

User Manuals

Quick Start Guides

Specification Sheets

Software Upgrades

Firmware Upgrades
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Features

Digital Video Recorder Features

• H.264 video compression1

• Real time recording @ 360x240 resolution, D1 capable (720x480)

• Pentaplex operation - View, Record, Playback, Back Up & Remotely Control the system 
simultaneously

• 24x7 100% duty cycle HDD

• Recording options: Motion, schedule, or continuous

• 2 x USB 2.0 ports (mouse, backup, firmware upgrade)

• Accurate Time Stamps with NTP & automatic Daylight Savings Time adjustments

• PTZ cameras supported (RS-485)

Connectivity Features2

• Instant Mobile Viewing on compatible smart phones & tablets3

• Exclusive LOREX Easy Connect Internet Set-up Wizard

• PC and Mac compatible (Internet Explorer & Safari browsers).

• Free LOREX DDNS (Dynamic Domain Name Service) for advanced remote connectivity at all 
times

• Instant email alerts with snap shot attachments and web link

1. Recording time may vary based on recording resolution & quality, lighting conditions, and movement in the 
scene.

2.  Requires a high speed Internet connection and a router (not included).
3. Smart phone & tablet Compatibility: iPad™, iPhone™, BlackBerry (supported model numbers: 9000, 9700, 

9800), Android (version 1.5 & above), Windows Mobile (6.0, 6.5), Symbian (3rd & 5th generation phones). Mobile 
phone data plan is required (not included). For the latest compatibility list check www.lorextechnology.com as 
new models become available in the market.

All trademarks belong to their respective owners. No claim is made to the exclusive right to use the trademarks 
listed, other than the trademarks owned by Lorex Technology Inc. We reserve the right to change models, con-
figurations, or specifications without notice or liability. 
viii
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Getting Started
The system comes with the following components:

12V DC POWER SUPPLY

INSTRUCTION MANUAL
QUICKSTART GUIDE
DOCUMENTATION CD

USB MOUSE ETHERNET CABLE

REMOTE CONTROL
(may not be exactly as 
shown)

DVR (DIGITAL VIDEO RECORDER)

HDMI CABLE
(included with 8/
16-channel models only)

AUDIO HARNESS CABLE
(included with 16-channel model 
only)

HARD DRIVE SIZE, NUMBER OF CHANNELS, AND CAMERA CONFIGURATION MAY VARY
BY MODEL. PLEASE REFER TO YOUR PACKAGE FOR SPECIFIC DETAILS.
CHECK YOUR PACKAGE TO CONFIRM THAT YOU HAVE RECEIVED THE COMPLETE SYSTEM, 
INCLUDING ALL COMPONENTS SHOWN ABOVE. 



Front Panel

4-Channel

1 IR Sensor: IR receiver for the remote control.
LED Indicators:
• PWR: Power LED.
• HDD: Hard disk activity LED.

2 Menu & Playback Controls:
• : In Playback Mode, press to rewind. Press repeatedly to increase rewind speed.
• : In Playback Mode, press to play / pause video. 

• In Live Viewing Mode, press to open the Search Menu to select playback time.

• : In Playback Mode, press to fast forward. Press repeatedly to increase fast forward speed.
• : In Playback Mode, press to stop video playback. 

• In Live Viewing Mode, press to stop DVR recording.

• Press and hold for 15 seconds to reset the DVR to the default resolution. DVR will reboot.

• : Press to stop / resume recording. When the channel displays a red box with the letter "C", 
the channel is recording.

• Menu / Esc: Opens the system menu. In menus, press to go back / exit menus.

3 Channel Controls:
• Ch1 - Ch4: Press to switch to Full-screen View of the selected channel.
• : In Live Viewing Mode, press to switch to 4-way Split-screen View (Quad View).

4 Navigation Buttons:
• : Press to move cursor up.
• : Press to move cursor down.
• : Press to move cursor left.
• : Press to move cursor right.

5 PTZ / : Within system menus: Press to confirm a selection. 
• In Live Viewing Mode, press to open the System Information window.
• In Live Viewing Mode, press and hold for 6 seconds to open the PTZ menu.

31 2 4

5
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8-Channel 

1 IR Sensor: IR receiver for the remote control.
LED Indicators:
• PWR: Power LED.
• HDD: Hard disk activity LED.

2 Menu & Playback Controls:
• : In Playback Mode, press to rewind. Press repeatedly to increase rewind speed.
• : In Playback Mode, press to play / pause video. 

• In Live Viewing Mode, press to open Search Menu to select playback time.

• : In Playback Mode, press to fast forward. Press repeatedly to increase fast forward speed.
• : In Playback Mode, press to stop video playback. 

• In Live Viewing Mode, press to stop DVR recording. Password required; does not override 
scheduled recording.

• Press and hold for 15 seconds to reset the DVR to the default resolution. DVR will reboot.

• : Press to stop / resume recording. When the channel displays a red box with the letter "C", 
the channel is recording.

• Menu / Esc: Opens the system menu. In menus, press to go back / exit menus.

3 Channel Controls for full screen view:

• Ch1/5: Press once to display channel 1. Press  twice and press 1/5 to view channel 5.

• CH 2/6: Press once to display channel 2. Press  twice and press 2/6 to view channel 6.

• CH3/7: Press once to display channel 3. Press  twice and press 3/7 to view channel 7.

• CH4/8: Press once to display channel 4. Press  twice and press 4/8 to view channel 8.

• : In Live Viewing Mode, press repeatedly to switch between Split-screen Viewing modes.

4 Navigation Buttons:
• : Press to move cursor up.
• : Press to move cursor down.
• : Press to move cursor left.
• : Press to move cursor right.

5 PTZ/ : Within system menus: Press to confirm a selection. 
• In Viewing mode, press to open the System Information window.
• In Viewing mode, press and hold for 6 seconds to open the PTZ menu.

31 2 4

5
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16-Channel

1 IR Sensor: IR receiver for the remote control.
LED Indicators:
• PWR: Power LED.
• HDD: Hard disk activity LED.

2 Menu & Playback Controls:
• : In Playback Mode, press to rewind. Press repeatedly to increase rewind speed.
• : In Playback Mode, press to play / pause video. 

• In Viewing mode, press to open Search Menu to select playback time.

• : In Playback Mode, press to fast forward. Press repeatedly to increase fast forward speed.
• : In Playback Mode, press to stop video playback. 

• In Live Viewing Mode, press to stop DVR recording. Password required; does not override 
scheduled recording.

• Press and hold for 15 seconds to reset the DVR to the default resolution. DVR will reboot. 
This does not work if the monitor is connected using HDMI.

• : Press to stop / resume recording. When the channel displays a red box with the letter "C", 
the channel is recording.

• Menu / Esc: Opens the system menu. In menus, press to go back / exit menus.

3 Channel Controls:
• Ch1 ~ Ch9: Press to view channel in Full-screen View.
• To access channels 10 and greater: Press 0 for channel 10 or 1+0 for channel 10, 1+1 for 

channel 11, 1+2 for channel 12, etc.

• : In Live Viewing Mode, press repeatedly to switch between Split-screen Viewing modes.

4 Navigation Buttons:

• : Press to move cursor up.
• : Press to move cursor down.
• : Press to move cursor left.
• :Press to move cursor right.

5 PTZ/ : Within system menus: Press to confirm a selection. 

• In Live Viewing Mode, press to open the System Information window.
• In Live Viewing Mode, press and hold for 6 seconds to open the PTZ menu.

31 2 4

5
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Rear Panel
4-Channel

8-Channel

1 DC12V: Connect the included AC power adapter.

2 On / Off Switch: Turns the DVR on or off.

3 PTZ / Alarm Block: Connect compatible PTZ cameras (not included) or alarm devices (not 
included).

4 LAN: Connect a CAT 5 RJ45 Ethernet cable for local and remote connectivity.

5 USB Ports: Connect a USB mouse (included) or USB flash drive (not included) for data 
backup or firmware updates.

6 HDMI: Connect to a HDMI-compatible TV or monitor (not included) to view the system 
interface.

NOTE: HDMI resolution is up-scaled. Connect an RCA cable (not included) to the Audio Out port 
to play audio from the DVR.

7 VGA: Connect a VGA monitor (not included) to view the system interface.

8 Video Output: Outputs the DVR interface to a BNC connection. This allows you to see your 
mouse cursor and have full control of the system on a secondary monitor.

NOTE: Use a BNC to RCA adapter (not included) to connect the DVR to RCA inputs (i.e. for a TV 
connection).

764 81 9 102 3

5
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Rear Panel
9 Video Input: Connect up to 4 BNC cameras (4-channel) or 8 BNC cameras (8-channel).

10 Audio Out: Output for 2 audio channels (e.g. speakers).

11 Audio In: Connect up to 4 RCA audio-enabled cameras (not included).

16-Channel

1 BNC Video IN: Connect up to 16 BNC cameras.

2 Video Out: Video outputs (BNC) for external monitors. For details, see “Appendix C: 
Connecting Additional External Monitors” on page 109.

NOTE: Use a BNC to RCA adapter (not included) to connect the DVR to RCA inputs (i.e. for a TV 
connection).

3 Audio In: Connect up to 4 RCA audio-enabled cameras (not included). BNC to RCA adapters 
required (not included).

4 Audio Out: Output for 2 audio channels (e.g. speakers). BNC to RCA adapters required (not 
included).

5 Audio In (CH5~16): Connect up to 12 RCA audio-enabled cameras (not included) using the 
Audio Harness cable (included). BNC to RCA adapters required (not included).

6 HDMI Out: Connect to a HDMI-compatible TV or monitor (not included) for multimedia audio 
and video (16-channel only). Note that the DVR cannot use an HDMI and VGA monitor at the 
same time.

7 VGA Output: Connect a VGA monitor (not included) to view the system interface. 

8 LAN: Connect a CAT 5 RJ45 Ethernet cable (included) for local and remote connectivity.

9 USB Ports: Connect a USB mouse (included) or USB flash drive (not included) for data 
backup or firmware updates.

10 PTZ / Alarm Block: Connect a PTZ camera (not included) and Alarm Devices (not included).

11 On / Off Switch: Turns the DVR on or off.

12 DC12V: Connect the included AC power adapter.

1 2 3 4 5 8 10 11 12

6 7 9
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Basic Setup
Basic Setup

Step 1: Connect the BNC Cameras
• Connect BNC cameras to the Video In ports on the rear panel of the DVR.

Step 2: Connect the Mouse
• Connect a USB mouse (included) to one of the USB ports on the rear panel of the DVR.

Step 3: Connect the Ethernet Cable
• Connect an ethernet cable (included) to the LAN port on the rear panel of the DVR. Connect 

the other end of the ethernet cable to a router on your network.

Push and twist the BNC 
connector clockwise to 
secure it to the BNC port.

8-channel model shown

8-channel model shown

USB ports

Connect ethernet cable

8-channel model shown

LAN port
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Basic Setup
Step 4: Connect the Monitor
• Connect a HDMI cable (included with 8/16-channel models only) from the HDMI port to the 

TV or monitor (recommended) OR;
• Connect a VGA cable (not included) from the VGA port to the monitor.

NOTE: If you have a monitor with a DVI input, you must use an HDMI to DVI adapter (not included). 
You cannot use an DVI to VGA adapter.

Step 5: Connect the Power Adapter and Power on the DVR
• Connect the included power adapter to the DC 12V port. Connect the end of the power adapter 

to a wall socket or a surge protector.
• Turn the power switch to I to turn on the DVR. At startup, the system performs a basic system 

check and runs an initial loading sequence. After a few moments, the system loads a live 
display view.

Step 6: Verify Camera Image
• Power on the cameras, and then verify the camera video quality before mounting the cameras 

to a permanent location.
• Mount the cameras under a sheltered location. Always verify the outdoor rating of your camera 

before installing it in a permanent location.

Step 7: Set the Time
• Set the system time and date for accurate video time stamps. Videos with inaccurate times 

may not be valid as surveillance evidence.
• For details on setting the system time, see “Setting the Date and Time” on page 20.

HDMI VGA

8-channel model shown

8-channel model shown

DC 12V port ON
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Basic Setup
Default System Password & Port Numbers

• The system requires a user name and password to log in to the system remotely using a 
computer or mobile device. 

• ALL the system port numbers below must be port forwarded on your router to log in to your 
system over the Internet or an internal network (LAN).

Local DVR user name and password:
• Username: ADMIN / Password: 000000

Default ports for remote access:
• Port 80 (HTTP port)
• Port 9000 (Client port)
• Port 1025 (Mobile port)

Remote connectivity (LAN & Internet) to the DVR:
• User Name: admin
• Password: none (left blank)

Mobile connectivity (e.g. iPhone) to the DVR:
• User Name: admin
• Password: 0000

Quick Access to System Information
• To quickly open a window that displays vital system information, press the PTZ /  button 

on the front panel of the system. 

By default, the system user name is admin and the password is 
000000. Passwords are disabled by default and are not required to 
access the Menu Bar or Main Menu. However, you may be asked for 
a password to access certain functions. It is recommended that you 
enable passwords and create your own password. For details, see 
“Managing Passwords” on page 29.

PTZ button
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Basic Setup
Connecting Cameras

Test the cameras before permanent installation. Plan where you will route the wiring for 
the camera and where you will aim the camera.

Installation Tips
• Mount the camera where the lens is away from direct and intense sunlight. 
• Plan your cable wiring so that it does not interfere with power lines or telephone lines.
• Ensure that the camera wiring is not exposed or easily cut.
• Mount the camera in an area that is visible, but out of reach.
• Avoid pointing the camera at a glass window to see outside, as this may result in a poor image 

caused by glare from indoor / outdoor lighting conditions. 
• Adjust the camera angle so that it covers an area with high traffic.
• In "high-risk" locations, have multiple cameras point in the same area. This provides camera 

redundancy if a vandal attempts to damage the camera.

Installing Cameras
1 Mount the camera(s) to the desired mounting surface according to the instructions that came 

with the camera(s). Choose a firm mounting surface.

NOTE: If you wish to mount cameras to drywall, it is recommended to use drywall plugs (not 
included).

2 Adjust the camera stand to ensure that the camera has a satisfactory view of the area you 
would like to monitor. Stand configuration depends on the mounting surface you have chosen 
(see below for suggested stand configurations).

NOTE: There are two connection points for certain cameras. Secure the stand to the top thread 
for wall mounts or ceiling mounts. Secure the stand to the bottom thread for table 
mounts or wall mounts.

ATTENTION: Cameras differ in terms of installation or mounting instructions. Please see 
the documentation that came with your camera(s) for specific installation instructions.

Table Mount Wall Mount Ceiling Mount

Camera model not be exactly as shown.

Top thread
(Ceiling mount, Wall mount)

Bottom thread
(Table mount)

Secure to camera 
thread

Camera model may not be exactly as shown.
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Basic Setup
Connecting BNC Cameras to your DVR
1 Connect the male power connector on the BNC extension cable to the female power 

connector on the camera.
• Connect the BNC connector to the camera.

2 Connect the female power connector on the BNC extension cable to the power adapter.

3 Connect the BNC connector to one of the Video Input ports on the rear panel of the DVR.

4 Plug the camera power adapter to a power outlet.

Connecting and Removing BNC Cables
BNC (Bayonet Nut Connector) is a special connector that locks on to the system port and 
cannot be accidently removed.

To connect or remove a BNC connector:
• Push the BNC connector firmly into the BNC port and simultaneously twist the connector 

clockwise to tighten.
• To remove a BNC connector from a BNC port, push and simultaneously twist the connector 

counter-clockwise to loosen the BNC connector.

BNC Extension cable

Female power connector

Digital Video Recorder
(8-channel model shown)

Male power connector

BNC
11



Mouse Control
Mouse Control
The DVR is designed for mouse navigation. To use a USB mouse (included), connect the 
mouse to a USB port on the rear panel of the DVR.

1 Use the mouse buttons to perform the following:
• Left-Button: Click to select a menu option. 

During live viewing in Split-screen View, 
double-click on a channel to view the selected 
channel in full-screen; double-click the 
channel again to return to Split-screen View.

2 Right-Button: 
• Click to open the Menu Bar (see “Using the 

Menu Bar” on page 16). 
• In menus, use the right-button to go back / exit 

menus.

3 Scroll-Wheel: No function.

8-channel model shown

USB ports

1 2

3
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Remote Control
Remote Control
You can also control the DVR using the included remote control.

4 & 8-Channel Remote Control
1 Number Keys (1-9): Press to select the desired 

channel in Full-screen View.

• : In Live Viewing Mode, press to open 
Split-screen View. Press repeatedly to switch 
between split-screen viewing modes.

• MENU: Press to open the Main Menu. In menus, 
press to go back / exit menus.

2 Navigation Cursors: Press to navigate menus.

• : Press to select menu items. In Live Viewing 
Mode, press to access System Information.

3 SUB MENU: Press to open the Menu Bar.

4 MUTE: Press to mute / un-mute audio during 
Live Viewing and Playback Mode*.

5 Playback Controls:

• : In Playback Mode, press to fast forward / 
increase fast forward speed.

• : In Playback Mode, press to rewind / 
increase rewind speed.

• : In Live Viewing Mode, press to open the 
Search Menu to select video for playback. 

• In Playback Mode, press to play video.

• : In Live Viewing Mode, press to start 
Sequence Mode. 

• In Playback Mode, press to pause video. 
Press repeatedly to step through video 
frames.

• : Press to stop recording. Password required; 
does not override scheduled recording.

• : Record: Press to resume recording after 
recording has been stopped. Password 
required.

1

2

3 4

5

*Audio capable cameras (not included) are required 
for audio recording and listen-in audio functionality.

TIP: When using the remote 
control to enter password 
and camera titles, select the 
field using the navigation 
buttons, press , and then 
press the number buttons.

.
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Remote Control
16-Channel Remote Control
1 REC: Press to resume recording after recording has 

been stopped.
• SEARCH: Press to open the Search menu.
• Number Keys (1-0): In Live Viewing Mode, press to 

open the desired channel in Full-screen view. Press 
1+0 for channel 10, 1+1 for channel 11, etc. 

• 0: Press 0 three times to show the mouse cursor 
on the BNC monitor or the monitor connected with 
HDMI/VGA.

• Display Mode: In Live Viewing Mode, press 
repeatedly to switch through split-screen viewing 
modes.

• 2x2 / 3x3 / 4x4: In Live Viewing Mode, press to open 
the corresponding Split-screen View. Press 
repeatedly to change channels shown in 
split-screen.

• AUTO: Press to start / stop Sequence Mode.

2 Navigation Cursors: Press to navigate menus.
• ENTER: In menus, press to confirm selections.

• In Live Viewing Mode, press to access System 
Information.

3 MENU/ESC: Press to open the system menu. In 
menus, press to go back / exit menu.
• MUTE: In Live Viewing and Playback Modes, press 

to mute / un-mute audio.
• PIP: In Live Viewing Mode, press once to open 

Picture in Picture (PIP) 1X1 or twice to open PIP 1X2. 
Mouse is required to change channels shown in PIP.

4 Playback Controls:
• FWD: In Playback Mode, press to fast forward / 

increase fast forward speed.
• REW: In Playback Mode, press to rewind / increase 

rewind speed.
• PLAY: In Playback Mode, press to play / pause video.

• In Live Viewing Mode, press to open the Record 
Search Menu.

• STOP: In Playback Mode, press to pause playback.
• In Live Viewing Mode, press to stop recording. Password required; does not override 

scheduled recording.

• SLOW: In Playback Mode, press to play video in slow motion. Press repeatedly to change slow 
motion playback speed.

• PAUSE/FRAME: In Playback Mode, press to pause. Press repeatedly to view recordings frame 
by frame.

1

2

3

4

5

5 PTZ Controls:

• Z+/Z- : Adjust camera Zoom.
• F+/F- : Adjust camera Focus.
• I+/I-: Adjust camera Iris.
• PTZ: Opens the PTZ menu.
14



Using the On-Screen Display
Using the On-Screen Display
Use the system’s graphical on-screen display to navigate menus and configure options and 
settings.

1 Date & Time: Displays the date and time on the system

2 Record Status: Displays the current recording status of the system: C=continuous (normal 
recording); M=motion recording; A=alarm recording.

3 Channel number / Channel title: Displays channel number or channel title. To rename the 
channel number to a title, see “Configuring Custom Channel Names” on page 33.

CM

C C

1. Date & Time

2. Record Status

3. Channel number / 
Channel Title

Tip:
If you can’t see your mouse cursor on screen (16-channel model only):
You may have switched output modes from VGA/HDMI to BNC. By default, the DVR 
outputs to VGA/HDMI mode at 1024 x 768 resolution. 

How To Change Video Outputs:

Front Panel Remote Control

16-Channel Press and hold 0 for 6 
seconds.

Press 0 three times.
15



Using the On-Screen Display
Using the Menu Bar
The Menu Bar allows you to access the Main Menu and control basic functions of the DVR.

To access the Menu Bar:
1 Right-click or move the mouse cursor to the bottom of the screen to access the Menu Bar.

Menu Bar Icons
• Main Menu: Opens the Main Menu.
• Lock: Click to Lock the Main Menu unless the password is entered. Lock icon is not visible 

unless passwords are enabled.
• Split Screen buttons: View the DVR in 4-way, 9-way (8/16-channel models only), or 16-way 

Split-screen Mode.
• PTZ: Opens the PTZ controls.
• Start / Stop PTZ Cruise: Start or stop the PTZ cruise function.
• Zoom: Opens digital zoom. Must be in Full-screen / Live Viewing Mode.
• Record Search: Opens the DVR Search Menu. This allows you to search for video recorded 

on the DVR.
• Start / Stop Recording: Start or stop DVR recording on all channels. Password required; does 

not override scheduled recording.
• Start / Stop SEQ: Start or stop Sequence Mode. In Sequence Mode, DVR automatically switches 

between channels every few seconds.
• PIP 1X1: Enable Picture in Picture Mode with 1 camera in full screen and 1 in a small window.
• PIP 1X2: Enable Picture in Picture Mode with 1 camera in full screen and 2 in small windows.
• Volume: Adjust the DVR volume (audio-capable cameras required, not included).

Main Menu
Split screen PTZ

Start / Stop 
PTZ Cruise

Search Menu

Start/Stop 
Recording

Sequence Volume

Zoom PIP1X1 PIP1X2

Lock
16



Using the On-Screen Display
Using the Virtual Keyboard and Mini-Keyboard
You can input numeric or text values using the on-screen virtual keyboard. You will need to 
use the Virtual Keyboard when entering your User ID and Password. The Virtual 
Mini-Keyboard is used to input numeric values, such as the time and date.

To use the Virtual Keyboard:
1 Using the mouse, click on an option or field, such as the User ID and Password fields (if 

passwords are enabled).
• The Virtual Keyboard opens.

• Click Shift to switch between upper and lowercase letters.
• Click to move the cursor between letters.

• Click  to Backspace/Delete.
• Click Enter to enter your selection.
• Click ESC to close the virtual keyboard.

To use the Virtual Mini-Keyboard:
1 Using the Mouse, click on an option or field, such as the Time or Date fields.

• The Virtual Mini-Keyboard opens.

• Click  to go back to the previous option.

• Click  to enter your selection.

Virtual Keyboard

Virtual Mini-Keyboard
17



Using the On-Screen Display
Using the Zoom Mode
Zoom Mode allows you to zoom in on an image while viewing your cameras live. This can 
be useful if you want to get a closer look at a situation.

To use the Zoom Mode:
1 In Live Viewing Mode, select the channel you want to zoom in on in full-screen (double-click 

the channel if you are in a Split-screen View).

2 Right-click to open the Menu Bar and select the Zoom button ( ). A Zoom icon appears on 
the screen.

3 Click and drag on the area of the screen you would like to enlarge. The image zooms in on the 
selected area.

• The box in the lower right-hand corner shows the entire camera picture with a black box 
around the zoomed-in area.

• Click inside the box and drag to move the zoom area.
• Right-click to exit and select a different zoom area. Right-click again to exit Zoom Mode and 

return to Live Viewing Mode.

Zoom icon

Click and drag to 
zoom in on an 
area

Click and drag inside the 
box to move the zoom area

Right-click to exit and select 
a different zoom area
18



Using the On-Screen Display
Using Picture in Picture (PIP) Mode
Picture in Picture (PIP) Mode allows you to view one channel in full-screen while viewing 
up to two other channels.

To use Picture in Picture Mode:

1 Right-click to open the Menu Bar and select the PIP1X1 button ( ) or PIP1X2 button ( ). 
PIP1X1 shows 1 channel in full screen and 1 other channel; PIP1X2 shows 1 channel in full 
screen and 2 other channels.

• Picture in Picture Mode opens.
• To change the full-screen channel, click anywhere in the main viewing area.
• To change the smaller channels, click inside the channel.
• To move the smaller channels around the screen, click inside the white bar and drag.
• Right-click to exit and return to Live Viewing Mode.

Click inside the main 
viewing area to change 
the full-screen channel

Click inside the white bar 
and drag to move the 
smaller channels

Click inside the smaller channels 
to change the channel
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Setting the Date and Time

To set the date and time:
1 Right-click or move your mouse to the bottom of the screen to open the Menu Bar and click 

the Main Menu button ( ).

2 Click System.

3 Configure the following:
• Date: Click inside the field and enter the month, date, and year.
• Time: Click inside the field and enter the time.
• (Optional) Date Format: Use the drop-down menu to select MM/DD/YY or, DD/MM/YY, or 

YY-MM-DD.
• (Optional) Time Format: Use the drop-down menu to select 12HOURS or 24HOURS.
• (Optional) DST: Click the Setup button next to DST to configure automatic Daylight Savings 

Time adjustments.
• (Optional) NTP: Click the Setup button next to NTP to synchronize your DVR’s time and date 

with a Network Time Protocol (NTP) time server. Lorex provides a free NTP service that 
automatically updates your DVR’s time for Daylight Savings Time.

NOTE: A constant internet connection is required for the NTP server feature to function.

4 Click Apply to save your settings.

It is highly recommended to set the date and time when first 
setting up your system. 

Inaccurate time stamps may render your footage unusable for 
court evidence.

Press  on the Mini-Keyboard after 
you have entered the Date or Time
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Configuring Daylight Savings Time (DST)
If your region observes Daylight Savings Time (DST), follow the instructions below to 
configure your DVR to automatically update the time when the clock updates.

To enable automatic DST adjustments:
1 Click the DST Setup button.

2 Configure the following:
• Daylight Saving Time: Select Enable.
• Time Offset: Select the number of hours the system should move forward or backward when 

DST occurs.
• Daylight Saving Time Mode: Select Week or Date. This allows you to select whether DST 

should begin and end at the beginning of the week or on a specific date.
• Start Time, End Time: Enter when DST starts and ends.

3 Click Apply to save your settings.

DST Setup

Select Enable

Configure DST 
Settings
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Setting the Date and Time
Using a NTP Server to set your System Time
A NTP (Network Time Protocol) server syncs your system time with an online time server. 
Lorex provides a free NTP service that allows your DVR to automatically update the time 
for Daylight Savings Time.

NOTE: A constant Internet connection is required to use the NTP feature.

To enable NTP:

1 Right-click to open the Menu Bar and click the Main Menu button ( ).

2 Click System. Beside NTP, click Setup.

3 Configure the following:
• Enable: Select Enable.
• Server Address: Select ntp.lorexddns.net (recommended) as the time server or select 

another time server.
• Time Zone: Select your region’s time zone.

4 Click Update Now to connect to the time server.

5 Click Apply to save your settings.

NTP Setup

Select Enable
Select ntp.lorexddns.net

Select your Time Zone

Click Update Now to connect 
to the server

Click Apply to save your settings
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Recording
Recording
By default, the system is set to immediately record video from connected cameras in 
Continuous Recording Mode.

•  Recording—Continuous: Normal, continuous recording

You can set the system to stop recording once the hard drive is full, or to continually record 
by overwriting previously recorded data. For more details, see “Configuring Hard Drive 
settings” on page 46.

Event Recording
The system also includes motion recording:

•  Recording—Motion: The system records when motion is detected by the camera

Recording Audio
The system can also record audio for up to 4 channels (4/8-channel models) or 16 channels 
(16-channel model). You must have audio-capable cameras (not included) or self-powered 
microphones (not included) in order to record audio on the system.

For details, see “Appendix D: Recording Audio” on page 111.

C
.

M
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Playback and Backup
Playback and Backup
You can view and back up recorded video on the system through the Search Menu.

To playback a specific date and time:

1 Right-click to open the Menu Bar and click the Record Search button ( ). The Record 
Search tab opens.

2 Configure the following:
• CH: Select the channel you wish to search. Select All to search all channels.
• Search Date: Enter the month, date, and year you wish to search for video.
• Playback Time: Enter the desired time you wish to search for video.

3 Click Play to select the exact time specified in Replay Time. 

4 Select the channel or channels you want to play back and click Play.

CH

Playback 
Time

Search 
Date

Select channels to play back
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Playback and Backup
To search for recorded footage on the DVR:

1 Right-click to open the Menu Bar and click the Record Search button ( ). The Record 
Search tab opens.

2 Configure the following:
• CH: Select the channel you wish to search. Select All to search all channels.
• Search Date: Enter the month, date, and year you wish to search for video.

3 Click the Search button. Your search results appear in the calendar. In the top portion of the 
calendar, results are shown for each day in the month. In the bottom portion, results are 
shown for each hour in the selected day.

4 Click on a date in the calendar to see the video available for that date.

5 Click on the hour of the video you want to play back.

6 Select the channel or channels you want to play back. 

7 Click Play to begin playback.

Days in the 
selected month

Hours in the 
selected day

Search results:
Green: Continuous recording
Red: Motion or alarm recording
Grey: No recording
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Playback and Backup
Using the On-Screen Playback Controls
1 Move the mouse slightly to display the on-screen playback controls. You can also use the 

playback control buttons on the remote control or front panel of the system.

2 Click the playback controls to play, pause, fast forward, rewind, and slow down playback.

3 Drag the slider to adjust the volume (audio capable camera required, not included). Click 
Mute to mute the audio.

4 Click X to quit playback and return to the Search Menu.

Backing Up Video
You can back up video to a USB flash drive (not included) connected to the rear panel of the 
DVR.

To back up video:
1 Connect a USB flash drive to one of the USB ports on the rear panel of the DVR.

2 Right-click to open the Menu Bar and click the Record Search button ( ).

3 Click the Backup tab.

4 Configure the following:
• Search Date: Enter the desired month, date, and year
• Search Time: Enter the time range you wish to search.
• CH: Select the channel you wish to search. To search all channels, select All.
• Type: Select the type of recording you wish to search. Choose from All, Continuous, or Alarm. 

Playback controls

Reverse playback

Slow Motion
Play

Pause / Frame by Frame

Fast Forward
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Playback and Backup
5 Click Search. A list of videos populate in the window.

6 Click  to scroll through the list of videos. The videos are named by time. Videos are 
"packed" into 15 minute - 60 minute increments.

7 Click the BAK checkbox beside the video you wish to back up.

8 Click Backup. Wait for the backup to finish before removing the USB memory drive.

Viewing Backed Up Video
To view the downloaded video, you must install the Lorex Player software.

For details on viewing backed up video, see “Lorex Player 11: Playing Backed up Video on 
PC” on page 87 or see “Lorex Player for Mac: Viewing Backed up Video on Mac” on page 89.

Converting Backed Up Video to AVI Files
The DVR saves its backup files as proprietary video files. To share these files, you must 
convert them into .AVI files. Note that the AVI generator can also back up audio from 
audio-enabled cameras.

To install the AVI converter:
1 Insert the software disc in your computer’s CD/DVD rom drive.

2 Locate the AVI Generator software from the CD installation wizard.

Click the BAK checkbox to select 
video to back up

Click Backup

NOTE: To change the duration of how often a file is "packaged", see “Configuring 
Backup File Duration (Pack Duration)” on page 36.
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Playback and Backup
3 Follow the on-screen instructions to install AVI Generator.

To start the AVI Generator:

1 Double-click the AVI Generator shortcut on the desktop ( ).

2 Click Open and then locate the backed up video file on your hard drive.

3 Select the desired file format (.264 , h.264, All File) that you wish to search for. Click Open.

4 Click Start to convert and save the file in the default save folder.
• Or click Save As to select a desired save folder, then click Start to convert the file.

5 Locate the file in the folder you selected in step 4.

Open

Open

Save As

Start
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Managing Passwords
Managing Passwords

When you first startup your system, you are technically logged in as the ADMIN (system 
administrator) account. The system supports the following account types:

• ADMIN—system administrator: has full control of the system, and can change both 
administrator and user passwords and enable/disable password protection.

• USER—normal user: only has access to live viewing, search, playback, and other functions. 
You may set up multiple USER accounts with varying levels of access to the system.

For security reasons, it is highly recommended to enable passwords on your system. If you 
enable passwords, you must select a 6-digit ADMIN password. By default, the system 
password is disabled.

Enabling and Changing Passwords
You can change the system password of the ADMIN and the USER from the Users menu.

To enable the admin password:

1 Right-click to open the Menu Bar and click the Main Menu button ( ).

2 Click System and select the Users tab.

3 Select the checkbox beside admin to change the admin password, then click the Edit button.

ATTENTION: By default, the system user name is admin and the password is 000000. Passwords 
are disabled by default and are not required to access the Menu Bar or Main Menu. However, you 
may be asked for a password to access certain functions.
You do not need to enter a password to access the system using the browser-based remote 
software.

Edit

Select checkbox beside admin
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Managing Passwords
4 Configure the following:
• User Name: Enter the desired admin user name.
• Password Enable: Select Enable to enable system passwords.
• Password: Enter your desired password.
• Confirm: Re-enter the password.

5 Click Apply to save your settings.

Adding Users
You can allow multiple users to log in to the system. When adding different users, you can 
assign what menus they have access to. For example, you may want your friend to monitor 
your system while you are away, while not giving full access to your system.

To add a new user:

1 Right-click to open the Menu Bar and Click the Main Menu button ( ).

2 Click System> Users tab.

3 Select the checkbox beside User1 (or any other user), then click the Permission button.

Select checkbox beside "User1"

Configure Permissions
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Managing Passwords
4 Select the menus and channels the user will have access to:

5 Click Apply to save your settings.

6 Configure the following:
• User Name: Enter the desired user name.
• User Enable: Select Enable to enable the user account.
• Password Enable: Select Enable or Disable to enable or disable the system from prompting 

you for a user or admin password during log in.
• Password: Enter your desired password.
• Confirm: Re-enter the password.

7 Click Apply to save your settings.
Now, you can log in to the system locally, or remotely using the user name or password 
you created. When logging into the system with a user account, the user will only have 
access to the menus you assigned.

Select the menus that the user will have access to.

Select which channels will have access to: 
Backup, Preview, Playback and PTZ Control.
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Using the Main Menu
Using the Main Menu
To open the Main Menu:

• Right-click to open the Menu Bar and click the Main Menu button ( ).

NOTE: If passwords are enabled on the system, you need to enter the 6-digit numerical password 
to open the Main Menu.

1 Display: Configure display options (e.g. camera color settings, camera title, video output).

2 Search: Search for recorded video and log files on the system.

3 Alarm: Configure motion detection and alarm settings.

4 System: Configure system time and user accounts.

5 Record: Configure recording settings and recording schedules.

6 Network: Configure system network settings (e.g. DDNS, email alert settings).

7 Device: Configure PTZ settings, HDD recording mode, HDD format option.

8 Advanced: Configure system restart schedule, perform firmware upgrades.
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Using the Main Menu
Display
The display menu allows you 
to configure camera image 
settings and video output 
settings.

Tip: If you want to apply settings to all 
channels, use the "Copy To" drop-down 
menu, and select All. Click the Copy 
button to copy the setting across all 
channels.

Configuring Custom Channel 
Names

1 Select the Live tab.

2 In the Channel drop-down menu, select 
the channel that you wish to rename.

3 Click the Name field. Use the Virtual 
Keyboard to enter in the new channel 
name.

4 Click Apply to save your settings.

Changing the Position of the 
Channel Name

1 Select the Live tab.

2 In the Channel drop-down menu, select 
the channel you would like to configure.

3 In the Position drop-down menu, select 
where you would like the channel names 
to appear:

• U-L: Upper left hand corner.
• D-L: Lower left hand corner.
• U-R: Upper right hand corner.
• D-R: Lower right hand corner.
• OFF: Do not display the channel name.

4 (Optional) Use the drop-downs next to 
Copy to copy settings to another channel 
or all channels. Click the Copy button to 
copy settings.

5 Click Apply to save your settings.

Adjusting Camera Color Settings
1 Select the Live tab.

2 In the Channel drop-down menu, select 
the channel that you wish to configure.

3 Click the Setup button next to Color. The 
Color Setup window opens.

4 Drag the slider to adjust the Hue, 
Brightness, Contrast, and Saturation.

5 Click Apply to save your settings.

Enabling Covert Recording
Covert Recording blanks out the screen 
so that it seems as if the system is not 
recording. Covert channels are only 
visible when the admin account logs in 
using a remote computer or mobile 
device.

To enable covert recording:
1 Select the Live tab.

2 In the Channel drop-down menu, select 
the channel you wish to hide.

Channel drop-down menu
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3 In the Covert drop-down menu, select 
Enable. 

4 Click Apply to save your settings.

Configuring the Time and 
Recording Time Display

To add/remove the time stamp in the 
system display:

1 In the Live Time and Record Time 
drop-down menu, select enable or disable.

2 Click Apply to save your settings.

Configuring Sequence Time
Sequence time refers to the amount of 
time a channel appears on the screen 
before changing to a different channel 
when the DVR is in Sequence Mode. For 
example, when Sequence Mode is on, 
channel 1 is shown for several seconds 
before switching to channel 2. 

To configure the sequence time:
1 Click the Output tab.

2 Click the SEQ Dwell time field and enter 
the time channels remains on-screen 
before changing to another channel.

3 Click Apply to save your settings.

Changing the Video-out Resolution
1 Click the Output tab.

2 Click the drop-down menu beside VGA 
Resolution and select the output 
resolution.

3 Click Apply to save your settings.

4 Right-click repeatedly to exit all menus. 
The DVR prompts you to restart. Click OK.

5 The DVR restarts and asks you to confirm 
the new resolution. Click Yes to confirm or 
No to revert to the old resolution. If you do 
nothing, the DVR will revert to the last 
selected resolution and restart.

NOTE: If you select a resolution that is 
greater than what your monitor 
supports, you may see a blank 
screen when your DVR restarts. If 
this occurs, do not do anything and 
wait until the DVR restarts. If the 
screen remains blank, press and 
hold the Stop button () on the front 
panel of the DVR until the DVR 
restarts. Your system resolution will 
default to 1024 x 768. 16-channel 
only: this method does not work if 
the monitor is connected using 
HDMI.

Restoring the System’s Resolution 
if you see a Blank Screen
If you see a blank screen on your 
monitor after turning on your system, 
the DVR’s output resolution may be 
higher than what your monitor 
supports. Follow the steps below to 
restore the DVR’s default resolution to 
1024 x 768.

NOTE: 16-channel only: this method does 
not work if the monitor is connected 
using HDMI.

To restore the DVR’s default 
resolution:

1 Ensure the power and video cables are 
properly connected.

2 Press and hold the Stop button () on the 
front panel of the DVR until the DVR 

SEQ Dwell time
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Using the Main Menu
restarts. The DVR will restart with the 
default resolution of 1024 x 768.

3 When the DVR restarts, click Yes to 
confirm the default resolution.

NOTE: If your system resolution is already 
in 1024 x 768, pressing and holding 
the Stop button will not restart the 
system.

Adjusting Menu Transparency
You can increase or decrease the 
transparency of the on-screen menus.

To adjust the transparency of 
on-screen menus:

1 Click the Output tab.

2 Drag the Transparency slider to adjust 
transparency.

3 Click Apply to save your settings.

Adjusting the Video Margin
If you connect your DVR to a BNC 
monitor, you can adjust the video 
margins.

NOTE: On the 16-channel model, you must 
select the BNC output mode to 
adjust the margins. Press 0 three 
times on the remote control to 
switch the output mode between 
BNC mode and VGA/HDMI mode. 
When BNC mode is selected, the 
mouse cursor appears on the BNC 
monitor.

To adjust the video margin:
1 Click the Output tab.

2 Click the Margin button.

3 Drag the sliders to the left or right to 
adjust the Left, Right, Top, or Bottom 
Margin.

4 Click Apply to save your settings and click 
OK to confirm.

Adding Privacy Zones
A privacy zone allows you to block out 
up to 4 portions of each channel with a 
black square.

To configure a privacy zone:
1 Click the Privacy Zone tab.

2 In the Channel drop-down menu, select 
the channel you wish to configure.

3 Configure the following:
• Channel: Select the channel you wish to 

configure.

Stop button ()

ATTENTION: Areas covered by privacy 
zones are not visible in recordings.

Privacy Zone
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Using the Main Menu
• Privacy Zone: Select ON to enable privacy 
zones or OFF to disable privacy zones.

• Area Setup: Select the Area1~4 
checkboxes to enable up to 4 privacy 
zones.

4 Click the Setup button next to Mask Area. 
The Privacy Area setup screen opens.

• Click on a privacy area and drag to change 
its location.

• Click on the edge of a privacy area and 
drag to resize a privacy area.

• Right-click when you are finished to exit.

5 (Optional) Use the drop-downs next to 
Copy to copy privacy areas to another 
channel or all channels. Click the Copy 
button to copy privacy areas.

6 Click Apply to save your settings.

Record
The Record menu allows you to 
configure recording settings, 
such as the recording resolution, 

recording schedule, and audio 
recording.

Configuring Pre-recording Settings
1 Select the Rec Para tab.

2 In the Channel drop-down menu, select 
the desired channel you wish to configure.

3 In the PreRecord drop-down menu, select 
Enable to enable pre-recording or Disable 
to disable pre-recording.

4 Click Apply to save your settings.

Configuring Backup File Duration 
(Pack Duration)
"Pack Duration" refers to the duration 
of a backed up file in the system. By 
default, a recording is "packaged" into 
15 minute video files.

To change the DVR’s backed up file 
size: 

1 Select the Rec Para tab.

2 In the Pack Duration drop-down menu, 
select the desired duration (15~60 
minutes).

3 Click Apply to save your settings.

Click and drag to move privacy zones

Click Inside the edge and drag to resize

File Size duration
36



Using the Main Menu
Changing the file size changes the 
duration of backed up files. For 
example, if you select 15 minutes as 
your file size, the system stores video 
files in 15 minute durations.

Configuring the Recording 
Schedule (Continuous, Motion, 
Alarm)

To configure the recording schedule:
1 Click the Schedule tab.

2 Configure the following:
• Channel: Select the channel you wish to 

configure the schedule for.
• Week: Select the day of the week you wish 

to configure.

3 Click inside the grid to configure the 
recording schedule:
• The recording schedule is arranged as a 

grid. Each row represents a recording type 
(Continuous, Motion, and Alarm), and each 
box represents an hour. 

• Recording for each recording type is 
enabled during the selected hour when the 
box is filled in with the corresponding 
color. Recording for each recording type is 
disabled for the selected hour when the 
box is gray.

4 (Optional): Use the top Copy and Copy To 
drop-down to copy the recording schedule 
to a specific day or all days. Click Copy to 
copy the schedule.

5 (Optional): Use the bottom Copy and Copy 
To drop-down to copy the recording 
schedule to a specific channel or all 
channels. Click Copy to copy the schedule.

6 Click Apply to save your settings.

Enabling Audio Recording
Audio-capable cameras are required 
(not included) for audio recording.

To enable audio recording:
1 Click the MainStream tab.

2 Beside the corresponding channel, select 
or deselect the checkbox under Audio to 
enable or disable audio recording.

3 Click Apply to save your settings.

Configuring Recording Quality, 
Resolution, and Video Frame Rate
You can configure the recording quality, 
recording resolution and video frame 
rate for each channel.

To change the recording quality, 
recording resolution, and video frame 
rate:

1 Click the MainStream tab.

Audio 
checkbox
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Using the Main Menu
2 Under the Quality drop-down menu, select 
from Good, Better, or Best to adjust the 
quality of recordings on each channel.

3 Under the Resolution drop-down menu, 
select the Recording Resolution for each 
channel: C1F (320x240), HD1 (720x240), or 
D1 (720x480).

4 Under the FPS drop-down menu, select 
the number of frames per second you want 
the DVR to record on each channel.

5 (Optional) Use the Copy and Copy To 
drop-down menus to copy recording 
settings to one or all channels. Click Copy 
to copy recording settings.

6 Click Apply to save your settings.

NOTE: Increasing the resolution or quality 
settings will decrease the amount of 
Frames per Second (FPS) the DVR 
can record. If you receive an error 
message when saving your changes, 
reduce the Resolution, Quality, or 
FPS and try again.

Search
The Search menu allows you 
to search for saved video on 
your system for playback and 
backup.

Searching for Video on the System
1 In the main menu, click Search, or click 

the Search Menu button ( ) in the 
menu bar.

2 In the CH drop-down menu, select the 
channel you wish to search or select All to 
search all channels.

3 Click the Search Date field, to enter the 
desired month, date, and year you wish to 
begin searching for video.

4 Click Search. 

5 Click on a date in the calendar to see the 
video available for that date.

Frames per Second

Recording 
Resolution

Recording quality

Search Date

Click a date to see video available

Click a time to play video from that time and date
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Using the Main Menu
6 Click on the hour of the video you want to 
play back.

7 Select the channel or channels you want to 
play back. 

8 Click Play to begin playback.

Video Playback Controls
Move the mouse slightly to display the 
on-screen playback controls. You can 
also use the playback control buttons on 
the remote control or front panel of the 
system.

• Drag the slider to adjust the volume (audio 
capable camera required, not included). 
Select the box to mute the audio.

• Click X to quit playback and return to the 
Search menu.

Backing up Video Files
You can back up video files on your USB 
flash drive. 

To back up video files:
1 Perform a search.

2 Insert a blank USB flash drive in the rear 
panel of the system.

3 Click on the desired date you wish to back 
up.

4 Click the Backup button. A list of files 
appears in the Log menu.

5 Click the checkbox under BAK next to the 
file you want to backup.

6 Click the Backup button to begin copying 
the video files to your flash drive.

NOTE: You will need the Lorex Player 
(included on the CD) to view the 
saved files.

Using the Event Search
Event Search allows you to find videos 
that are marked as "Alarm" or 
"Continuous" recording type. This 
allows you to quickly and easily sort 
though videos that only have alarm 
attributes.

NOTE: Videos are not marked as Alarm 
unless continuous recording is 
turned off and motion or alarm 
settings are enabled.

Use the video control buttons to 
manipulate video playback

Backup
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To perform an Event Search:

1 Click the Event Search tab.

2 Configure the following:
• Search Date: Enter the Month, Date, and 

Year.
• CH: Select the channels you wish to 

search.
• Search Time: Enter the time range you 

wish to search.
• Type: Select the recording type you wish 

to search for.

3 Click Search. A list populates with videos.

4 Perform one of the following:
• Play video: Double-click on the desired 

file.
• Back up a file: Connect a blank USB flash 

drive to your system. Select the BAK 
checkbox beside the desired file name. 
Then, click the Backup button.

Using the Log Search
A log search allows you to search 
system event logs.

To perform a Log search:
1 Click the Log tab.

2 Configure the following to perform a Log 
search:
• Log Type: Select the log type you wish to 

search under. Choose from Alarm (i.e. 
motion events), Operation (i.e. 
Configuration changes, Setup), or All.

• Start Time: Enter the time you wish to 
begin searching.

• End Time: Enter the time you wish to end 
searching. 

3 Click Search.

4 (Optional) Click the Backup button to 
backup system logs to a USB flash drive 
(not included).
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Network
The Network menu allows 
you to configure the 
system’s DDNS and 
network settings.

Configuring Network Type: DHCP & 
Static IP
The system has the ability to operate in 
DHCP mode and Static IP mode.

DHCP allows the router to assign an IP 
to the DVR. Static IP mode fixes the IP of 
the DVR. Fixing an IP of the DVR 
ensures that the IP will not change.

To configure DHCP and Static IP 
settings:

1 Select the Network tab.

2 In the Type drop-down menu, select DHCP 
or Static. If you select DHCP, the router 
automatically assigns an IP to your DVR.

If you select Static, click the field beside IP 
Address, and enter in the IP address of 
your choice.
• Enter your custom Subnet Mask, 

Gateway, DNS1 and DNS2 using the 
mouse.

• You must assign the IP in your router that 
you wish to make static. For example, if 
you assign 192.168.2.89 as the static IP in 
the DVR, you must assign 192.168.2.89 in 
your router as a static IP as well. Consult 
your router’s user’s manual for details.

3 Click Apply to save your settings.

4 Right-click until you exit all menus. You 
will be prompted to restart.

Enabling Auto Port Forwarding
Auto Port Forwarding allows the DVR to 
open required ports on your router. This 
feature only works on certain router 
models. If the Auto Port Forwarding 
feature does not work on your router, it 
is recommended to use the Auto Port 
Forwarding Wizard (PC only), located on 
the software CD. You may have to 
manually open the port on your router. 

To Enable Auto Port Forwarding:
1 Select the Network tab.

2 In the Auto Port Forwarding drop-down 
menu, select Enable or Disable.

3 Click Apply to save your settings.

Changing the DVR’s Client and 
HTTP Port
The DVR’s Default Client port is 9000. 
The default HTTP port is 80. You must 
port forward the Client Port and HTTP 
port to your router for remote access. 

To change the default Client port and 
HTTP port:

1 Select the Network tab.

2 In Client Port, enter the desired Client 
Port (default: 9000).

NOTE: 9000 is represented as "09000."

Select DHCP or Static

Client Port & HTTP Port fields
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3 In HTTP Port, enter the desired HTTP Port 
(default: 80).

4 Click Apply to save your settings.

5 Right-click to exit all menus. You will be 
prompted to restart.

Adjusting Remote Connectivity 
Streaming Rates
You can adjust the data streaming rate 
(also called the SubStream) when you 
connect to the system remotely. If you 
want to conserve bandwidth, select a 
lower frame rate and bitrate. 

NOTE: Setting your system to stream with a 
lower frame and bitrate may cause 
the video to appear choppy or slow. 

To adjust the SubStream settings:
1 Click the SubStream tab.

2 Configure the following beside the desired 
channel:
• Video: Select Enabled or Disabled. If you 

select Disabled, you will not be able to view 
the channel when connecting remotely to 
the system.

• FPS: Select the desired frames per 
second.

• Bitrate: Select the desired video bitrate.
• Audio: Select or deselect the checkbox to 

enable or disable the system from 
streaming audio when viewing the system 
remotely.

3 Click Apply to save your settings.

Setting up Email Notification
The system can send email notifications 
when it detects motion or when an 
alarm parameter triggers.

To set up email notification:
1 Click the Email tab in the Network menu.

2 From the Email drop-down menu, select 
from:
• Default: Uses the Lorex email server to 

send out alarm notifications. This is the 
recommended selection.

• Enable: Uses custom email server 
settings.

• Disable: Disables email notification.

If you want to use Lorex’s email server 
(recommended):

1 In the Email drop-down menu, select 
Default.

2 In the Sender Email field, enter the email 
address of the sender. This can be any 
email address of your choice.

Select Default
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3 In the Receiver Email field, enter the 
email address you want the DVR to send 
alarm notifications to.

4 In the Interval drop-down menu, enter the 
Duration the DVR must wait before 
sending out a new notification. 

For example, if you select a 3 minute 
interval, the DVR will send out email 
notifications every 3 minutes until the DVR 
stops detecting motion / alarm. The DVR 
will only send out notifications when it 
detects motion/alarm triggers.

5 Click Apply to save your settings.

If you select "Enable", and want to use 
your own email server:

1 Configure the following:
• SSL: Select ON/OFF to enable/disable 

Secure Socket Layer protocol.
• SMTP Port: Enter your SMTP address.
• SMTP Server: Enter your SMTP Server.
• Sender Email: Enter the sender email 

address. This can be any address of your 
choice.

• Sender Password: Enter your email 
server’s password.

• Receiver Email: Enter the recipient’s 
email address.

• Interval: Enter the interval the DVR waits 
before sending a new email notification. 

2 Click Apply to save your settings.

Changing the Mobile Connectivity 
Port, User Name, and Password
To connect to your DVR using a mobile 
device, you must complete the entire 
remote setup process described in 
“Setting up your DVR for Remote 
Connectivity” on page 51.

Use the steps below to change your 
Mobile Port or the user name and 
password used to connect with a mobile 
device.

To configure mobile connectivity 
settings:

1 Click the Mobile tab.

2 If you want to change the user name and 
password used to connect to the DVR using 
a mobile device:
• Under User Name, enter a new user 

name. Under Password, enter a new 
password.

• By default, the user name is admin and 
the password is 0000 to connect with a 
mobile device.

3 To change the Mobile port, click the field 
beside Mobile Port to enter a new port.
• The default Mobile port is 1025. This must 

be port forwarded on your router to enable 
remote access. Note that 1025 is 
represented as "01025".

4 Click Apply to save your settings.

5 Right-click until you have exited all menus. 
You will be prompted to restart.

Configuring DDNS settings
You must create a DDNS account and 
enter your DDNS settings into the DVR 
before you can remotely connect to your 
system.

For details on creating a DDNS account, 
see “Setting up your DVR for Remote 
Connectivity” on page 51.
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To configure DDNS settings:
1 Click the DDNS tab.

2 Configure the following:
• DDNS: Select Enable
• Server: Select LOREXDDNS (default).
• Domain Name: Enter the Domain name/

URL Request you received in the email 
after registering for DDNS.

• User Name: Enter your DDNS User Name.
• Password: Enter your DDNS Device 

password.

3 Click Apply to save your settings.

NOTE: Please allow 10~15 minutes for the 
DDNS servers to update with your 
new DDNS address before 
attempting to connect.

Alarm
The Alarm tab allows you to 
configure Motion Detection 
and Alarm settings.

Configuring Motion Detection
Configure motion settings to determine 
the area you wish to monitor for motion 
events, and the outcome if a motion 
event occurs.

To configure motion settings:
1 Select the Motion tab.

2 Configure the following:
• Channel: Select the channel you wish to 

configure.
• Enable: Select Enable or Disable to 

activate or deactivate motion recording.
• Area: Click the Setup button to configure 

the area of the screen that detects motion. 

Drag mouse cursor 
over desired area

Click and drag the mouse cursor to configure motion 
detection areas. Motion detection is enabled in red areas 
and disabled in transparent areas. Right-click to exit.
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• Sensitivity: Select motion sensitivity. The 
greater the number, the greater the 
sensitivity.

• Alarm Out: Select the checkbox to enable 
the system to trigger a device connected 
to the alarm block.

• Latch Time: Enter the duration the alarm 
continues to trigger after the event ends.

• Show Message: Select the checkbox if you 
want the system to display a system 
message when an alarm triggers.

• Buzzer: Select the duration the system 
will "beep" when motion is detected. Or 
select OFF to disable the "beep" during 
motion events.

• Send Email: Select the checkbox if you 
want the system to send email 
notifications if an alarm triggers. Email 
notifications must be configured.

• Record Channel: Select the channel you 
wish the DVR to record during motion 
recording.

• Full Screen: Select the Full Screen check 
box so that the system goes into full screen 
mode when motion or an alarm trigger is 
detected.

• Post Recording: Enter the post recording 
duration (the time the system continues to 
record after a motion event occurs).

3 Click Apply to save your settings.

Configuring Alarm Settings
The Alarm settings menu allows you to 
configure how the system behaves 
when an external alarm device (not 
included) is triggered. 

To configure the Alarm tab:
1 From the Alarm menu, click the Alarm 

tab.

2 Configure the following:
• Alarm In: Select the channel you wish to 

configure.
• Alarm Type: Select the alarm type of the 

device. Choose from N/O (normally open), 
N/C (normally closed).

• Alarm Out: Select the checkbox to enable 
the system’s alarm block to trigger a 
connected external alarm.

• Latch Time: Enter the duration the alarm 
continues to trigger after the event ends.

• Show Message: Select the checkbox if you 
want the system to display a system 
message when an alarm triggers.

• Buzzer: Select the checkbox to enable the 
system to "beep" if an alarm triggers.

• Send Email: Select the checkbox if you 
want the system to send email 
notifications if an alarm triggers.

• Post Recording: Select the duration the 
system continues to record as an event 
after the alarm trigger ends. For example, 
if you select 30s (30 seconds), the system 
continues to record for 30 seconds after 
the alarm trigger ends.

• Full Screen: Select the Full Screen check 
box so that the system goes into full screen 
mode when motion or an alarm trigger is 
detected.

3 Click Apply to save your settings.
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Device
The Device menu allows 
you to configure hard drive 
and PTZ settings and 
format a USB flash drive 
(not included).

• For details on connecting PTZ cameras 
(not included), see “Appendix B: 
Connecting a PTZ Camera” on page 106.

Configuring Hard Drive settings

To format the hard drive:

1 Select the HDD tab.

2 Click the checkbox under Select to choose 
the drive you wish to reformat.

3 Click Format HDD. 

4 When the warning window appears, click 
OK. Wait for the system to format the hard 
drive.

To set the hard drive recording mode 
(loop recording or linear recording):

1 Select the HDD tab.

2 Select the checkbox beside the hard drive 
you wish to configure.

3 In the Overwrite drop-down menu, select 
Auto. (recommended), or select the 
desired duration the hard drive should 
retain its data.

NOTE: If overwrite recording is enabled, the 
system’s hard drive automatically 
re-writes the hard drive’s oldest 
content (first in first out).

4 Click Apply to save your settings.

Formatting USB Flash Drives

1 Insert a USB flash drive (not included) into 
one of the USB ports on the rear panel of 
the DVR.

2 In the main menu, Device>HDD.

3 Click Format USB, then click OK. Wait for 
formatting to complete.

ATTENTION: Formatting the HDD 
erases all data on the hard disk. 
This step cannot be undone.

ATTENTION: Formatting a USB flash 
drive erases all data on the drive. 
This step cannot be undone.
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System
The System tab allows you to 
configure the system time 
and user accounts.

• For instructions on how to set the system 
time, including how to setup automatic 
Daylight Savings Time adjustments or 
NTP, see “Setting the Date and Time” on 
page 20.

Changing Date Format
You can change the way the system 
displays the time (i.e. Month, Day, Year)

To change the date format:
1 Select the General tab.

2 In the Date Format drop-down menu, 
select the desired format. Choose from 
MM/DD/YY (Month, Day, Year), YY/MM/DD 
(Year, Month, Date), or DD/MM/YY (Day, 
Month, Year).

3 Click Apply to save your settings.

Changing Time Format
You can change the way the system 
displays the date and time format (i.e 
6:00 pm or 18:00).

To change the time format:
1 Select the General tab.

2 In the Time Format drop-down menu, 
select 12 Hour or 24 Hour. 

3 Click Apply to save your settings.

Changing the System Language
1 In the Language drop-down menu, select 

your desired system language.

2 Click Apply to save your settings.

3 Right-click until you exit the menu. Follow 
the on-screen instructions to restart your 
system.

Changing Video Output - NTSC & 
PAL

To change the video output:
1 In the Video Format drop-down menu, 

select NTSC or PAL.

2 Click Apply to save your settings.

Configuring Menu Time Out and 
Auto Logout
The Menu Time Out setting allows you 
to configure how long the system menu 
will remain on the screen during 
inactivity. If passwords are enabled, it 
also configures the Auto Logout time, 
which allows the system to lock itself 
after a set duration of inactivity.

To configure Auto Logout:
1 Select the General tab General. In the 

Menu Time Out drop-down menu, select 
the desired time before the system locks 
itself.

2 Click Apply to save your settings.

NOTE: You will need your system’s user 
name and password to unlock the 
system.

Adding Users & Changing the 
Admin Password
• For details on changing admin and user 

passwords, see “Managing Passwords” on 
page 29.

• For details on creating User accounts, see 
“Adding Users” on page 30.

Viewing System Information
• Click the Info tab.
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Advanced
The Advanced menu allows 
you to update system 
firmware, load system 
defaults.

Configuring the "Auto Reboot" 
feature
Auto Reboot allows the system to 
restart during a specified time and date. 
Restarting the system every so often 
ensures system stability.

To enable the Auto Reboot feature:
1 Select the Maintain tab.

2 Configure the following:
• Auto Reboot: Select Enable or Disable to 

activate or deactivate the Auto Reboot 
feature.

• Reboot: In the drop down menu, select 
how often the system restarts. Choose 
from Every day, Every Week, or Every 
Month. Enter the desired day and time you 
want the system to restart.

3 Click Apply to save your settings.

Upgrading the System Firmware
Firmware upgrades can provide 
improved functionality to your DVR. 
When firmware upgrades become 
available, you can download them for 
free from www.lorextechnology.com.

To upgrade the system firmware:
1 In your web browser, visit 

www.lorextechnology.com and search for 
the model number of your DVR (check the 
label underneath your DVR for the model 
number). Download the free firmware 
upgrade if one is available.

2 Extract the firmware into a blank USB 
flash drive. The firmware should be in a 
folder named dvrupgrade. Ensure that 
this is the only folder in the USB drive.

3 Insert the flash drive into one of the USB 
ports in the rear panel of your DVR.

4 Right-click to open the Menu Bar and click 

the Main Menu button ( ).

5 Click Advanced.

6 Click Firmware Update.

7 Follow the on-screen instructions to 
update the firmware. Do not remove the 
USB flash drive or power off the DVR 
during the firmware update. Wait for the 
system to reboot.

Firmware Update
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Restoring to Factory Default 
Settings
Restoring to factory default settings 
reverts any setting changes you have 
made to their original settings. This 
does not affect the recordings saved on 
the DVR. You can reset a single menu, 
or all menus.

To load system defaults:
1 Right-click to open the Menu Bar and click 

the Main Menu button ( ).

2 Click Advanced. Then click Load Default.

3 Select the menus that you wish to restore 
to default settings, or click All to restore 
the entire system to default settings.

4 Click Apply.

5 When the warning window appears, click 
OK to restore your settings.

6 Click OK to return to the menu.

7 Right-click until you have exited all menus. 
The DVR prompts you to restart.

Restarting or Shutting Down the 
DVR

To restart or shut down the DVR:
1 Right-click to open the Menu Bar and click 

the Main Menu button ( ).

2 Click Advanced.

3 Click Reboot or Shut Down.

4 Follow the on-screen instructions to 
restart or shut down your system.

Configuring System Warnings
The system can send out email 
notifications, or trigger a connected 
alarm device if it detects system 
abnormalities. For example, the system 
can send out a warning if the hard drive 
is low on storage.

Reboot / Shut Down
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To configure system warnings:
1 Click the Events tab.

2 Configure the following:
• Event Type: Select the event that triggers 

the system to send out a notification or 
alarm trigger. Choose from Disk No Space 
(low hard drive space), Disk Error (hard 
drive error), or Video Loss.

• Enable: Select Enable or Disable to 
activate or deactivate the system from 
sending out notifications.

• Alarm Out: Select the checkbox to enable 
alarm out devices from triggering.

• Show Message: Select the checkbox for 
the system to display an error message 
when an event occurs.

• Send Email: Select the checkbox for the 
system to send out email notifications 
when a system error occurs. Note, email 
notifications must be configured.

• Latch Time: Select the delay duration in 
the drop-down menu.

• Buzzer: Select the buzzer (system beep) 
duration when the system detects a 
system error.

3 Click Apply to save your settings.
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Setting up your DVR for Remote Connectivity
The system features a built-in browser-based software that allows you to access your 
system remotely over your local area network (LAN) or over the Internet using Internet 
Explorer® (PC) or Safari® (Mac). There is also a client software for PC provided on the CD 
(see “Lorex Client 11: Client Software for PC” on page 62 for details).

System Requirements
Prior to using Lorex Web Client, make sure your system meets or exceeds the following 
system requirements:

NOTE: If a user connects to the system remotely, there may be slow performance when 
accessing the system locally. This is normal, and not a malfunction.

Description Requirement

CPU Pentium® 4 or above

Operating 
System

Windows XP/Vista/7 

Mac OSX 10.6.6 and above (Intel processors only)**

Memory 256 MB RAM or greater

Video 16 MB of video memory

Network (LAN) 10/100 BaseT Network

Network (WAN) 384 Kbps upstream*

*High-speed Internet service is recommended when using DVR Netviewer.

Browser Internet Explorer 7 or later (PC) / Safari 5.0 and above** (Mac)

Remote Viewing Client
For details on navigating the remote viewing interface, 
see “Remote Viewing Interface” on page 63.

** For the latest compatibility list, check www.lorextechnology.com, as new software versions are released 
to the market.
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Accessing your DVR within a local network (LAN)
You can connect to your DVR through Internet Explorer through the local area network 
(LAN). It is recommended to confirm connectivity over a local network before setting up 
your DVR for Internet connectivity.

NOTE: To complete the steps below, your computer must be on the same network as your DVR.

NOTE: Except where noted, the instructions below are the same for PC and Mac.

Step 1 of 3: Connect your DVR to the Local Area Network
1 Power off your DVR by turning the power switch to .

2 Connect an Ethernet cable (included) to the LAN port on the rear panel of the DVR. Connect 
the other end of the Ethernet cable to an empty LAN port (usually numbered 1~4) on your 
router.

3 Turn the power switch to I to power the DVR back on.

Step 2 of 3: Obtain the DVR’s Local IP Address and HTTP Port
1 Press the PTZ/  button on the front panel of the DVR to open the System Information 

window.

ROUTER
(Not Included)

COMPUTER
(Not Included)

(not required for 
local viewing)

INTERNET

Ethernet Cable (included)

8-channel model shown

DVR IP address

HTTP Port
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2 Write down the IP Address and HTTP Port number of the DVR. 
• A local IP looks something like this: 192.168.5.118. Note that single digit numbers appear as 

three digits. For example, "005" is the same as "5".
• Write down the port number beside HTTP Port.

Step 3 of 3: Enter the DVR’s Local IP Address into the Browser
Follow the steps below to confirm connectivity over a local network on a PC or Mac.

To connect using the DVR’s local IP address on a PC:
1 Open Internet Explorer.

NOTE: If you are connecting using Internet Explorer 9, you must use the 32-bit version. From 
the Start Menu, click Internet Explorer. Do not click Internet Explorer (64-bit).

2 Enter http://, the IP address of the DVR, colon, and the HTTP port number of the DVR (e.g. 
http://192.168.5.118:80) into the address bar. You must include the HTTP port number of the 
DVR after the address.

Example (Connecting to a Local IP Address using Internet Explorer):

3 An attention bar prompts you to install ActiveX® plug-ins. You must install the ActiveX® 
plug-in to connect to your DVR. Click inside the attention bar, and select Install this Add-on 
for All Users on This Computer to install the plug-in.

32-bit Internet 
Explorer

Local DVR IP Address HTTP Port number

Colonhttp://

Select Install this Add-on for All Users on This ComputerClick inside the attention bar
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• If you are connecting using Internet Explorer 9, the attention bar appears on the bottom of 
the screen. Click Allow to install the plug-in.

4 Under User Name and Password, enter the DVR’s username and password. By default, the 
username is admin and the password is left blank.

5 Click Login to log into the system.

NOTE: If you are having difficulty logging into your system using Internet Explorer, it is 
recommended to use the Client Software provided on the CD or as a free download from 
www.lorextechnology.com. For instructions, see “Lorex Client 11: Client Software for 
PC” on page 62.

To connect to the DVR’s local IP address on a Mac:
1 Open Safari.

2 Enter http://, the IP address of the DVR, colon, and the HTTP port number of the DVR (e.g. 
http://192.168.5.118:80) into the address bar. You must include the HTTP port number of the 
DVR after the address. A page appears to prompt you to install a plug-in.

Example (Connecting to a Local IP Address using Safari):

3 Click Download to download the plug-in for Safari.

Attention Bar in Internet Explorer 9 Click Allow

Local DVR IP HTTP Port number

Colonhttp://

Click Download
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4 Click the downloads button ( ) on the top-right corner of Safari. Right-click 
SurveillanceClient.dmg in the downloads list and select Open. A web plugin folder appears.

5 Double-click SurveillanceClient and follow the on-screen instructions to install.

6 Quit Safari (right-click the Safari icon in the 
dock and select Quit) and then restart 
Safari.

7 Enter http://, the IP address of the DVR, 
colon, and the HTTP port number of the 
DVR (e.g. http://192.168.5.118:80) into the 
address bar, as shown above.

8 Enter the DVR username and password to log in to the system. By default, the username is 
admin, and the password is left blank.

Accessing your DVR Remotely over the Internet
Setting up remote connectivity allows you to view your DVR from any computer or 
compatible mobile device with Internet access.

NOTE: Except where noted, the instructions below are the same for PC and Mac.

To set up remote connectivity with your DVR, you must:
1 Port forward the HTTP, Client, and Mobile ports (default: 80, 9000, and 1025) on your router 

to your DVR’s IP address.
2 Create a DDNS account.
3 Enable DDNS on the DVR.
4 Test the remote connection by entering your DDNS address in a web browser.

Step 1 of 4: Port Forwarding
You must port forward the HTTP, Client, and Mobile ports (default: 80, 9000, and 1025) on 
your router to your DVR’s IP address before you can remotely connect to your system. 
There are several methods to port forward your router:

• Use the Lorex Easy Connect Auto Port Forwarding Wizard (PC only) to port forward the 
required ports (see CD for details). For instructions on how to use the Easy Connect Wizard, 
see the Easy Connect manual on the CD.

Right-click 
SurveillanceClient.dmg 
and click Open

Right-click Safari 
and click Quit
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• Manually port forward the required ports on your router to your DVR’s IP address by 
following your router manufacturer’s instructions. For more information on port 
forwarding, see the reference guides on www.lorextechnology.com.

NOTE: If the above ports are not forwarded on your router, you will not be able to access your 
system remotely.

Step 2 of 4: Create a DDNS Account
Lorex offers a free DDNS service for use with your system. A DDNS account allows you to 
set up a web site address that points back to your local network. This allows you to connect 
to your system remotely. You must create a DDNS account in the same network as your 
DVR.

To setup your free Lorex DDNS account:
1 In your browser, go to http://www.lorexddns.net and click Step 1.

2 The My Lorex account login screen opens (if you are already logged in, skip to step 4). Create 
a new account or log into an existing account. To create a new account, fill in the required 
fields on the right and click Create Account.

Click Step 1

Enter your account Information 
and click Create Account

Click Create Account
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3 Click Warranties to register your product for warranty.

NOTE: Warranty registration is required to register for DDNS.

4 The Warranty page opens. Click Activate Warranty to register your product for warranty.

5 Under Your Address, select an address or click Enter a New Address to create a new address. 
Fill in your address information and click Create Address.

Click Warranties

Enter your address 
information

Click Create Address
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6 Fill in the warranty registration form with your product and purchase details. Check the 
sticker underneath your DVR for the Product Model Number and Serial Number. Click Save 
Warranty.

7 A page pops up to prompt you to register your product for Lorex DDNS. Click Set Up a New 
DDNS.

Select your address or 
enter a new address

Enter your product and 
purchase details

Click Save Warranty

Click Set Up a New DDNS
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8 Configure the following:

• Product Warranty: Select the product warranty you created in the previous steps.
• Device Name: Enter a name for your device. You can enter your name, business name, or 

anything of your choice. This is used to identify this device in your list of activated DDNS 
accounts that appears anytime you visit the DDNS page.

• MAC Address: Enter the MAC address of your Lorex product. Press the PTZ/  button 
on the front panel to find your MAC address. A MAC address is a permanent, unique 12-digit 
address used to identify a device on a network.

• URL Request: Enter the web site address that will be used to connect to your Lorex product. 
For example, if you enter tomsmith, the address to access your video will be 
http://tomsmith.lorexddns.net

9 Click Save to register your product for DDNS. A confirmation email will be sent to the email 
address used to register for My Lorex.
You will need this information to enable remote access to your system. Record your 
information below:

Select your product 
warranty

Enter a Device Name 
of your choice

Enter the product’s 
MAC address

Enter the web site 
address that will be 
used to connect

Click Save

MAC Address

Domain name/URL Request:

DDNS User Name:

Device DDNS password:
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Step 3 of 4: Enable DDNS on the DVR

To enable DDNS in your DVR:

1 Right-click to open the Menu Bar and click the Main Menu button ( ).

2 Click Network and select the DDNS tab.

3 In the DDNS drop-down menu, select Enable. Beside Server, select LOREXDDNS (default).

4 Under Domain Name, enter your Domain name/URL Request from the confirmation email 
that was sent after you created your DDNS account. 

5 Under User Name, enter your DDNS User Name that was emailed to you after DDNS 
registration.

6 Under Password, enter your DDNS Device password that was emailed to you after DDNS 
registration.

7 Click Apply to save your settings.

Select Enable

Domain Name: Enter Domain name/URL Request
User Name: Enter DDNS User Name
Password: Enter DDNS Device password

tomsmith

tsmith01

******

Example of entering DDNS information in the 
DDNS setup menu
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Step 4 of 4: Enter the DDNS Address into the Browser

NOTE: Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address 
before attempting to connect.

To access your DVR remotely, enter the DDNS address that you created earlier into 
Internet Explorer (PC) or Safari (Mac). The DDNS address must include http:// , the name 
of your DDNS URL, followed by .lorexddns.net, a colon, and then the HTTP port number of 
your DVR. 

For example:

Once you have entered your DDNS address into Internet Explorer or Safari, enter the DVR 
user name and password at the login screen and click Login. 

NOTE: To log in remotely, the default user name is admin. The password is left blank.

NOTE: If you are having difficulty logging into your system using Internet Explorer, it is 
recommended to use the Client Software provided on the CD or as a free download from 
www.lorextechnology.com. For instructions, see “Lorex Client 11: Client Software for 
PC” on page 62.

Domain name/URL Request HTTP Port number

Colon

Example of a DDNS address

http://tomsmith.lorexddns.net:80

DDNS Domain name created by you Colon

Web Server Port number

http://

.lorexddns.net
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Lorex Client 11: Client Software for PC
Lorex Client 11 is a client software for PC that allows you to connect to your DVR on a PC 
and view your cameras from anywhere in the world.

NOTE: Before you can connect to your DVR over the Internet, you must complete port forwarding 
and DDNS setup. For details, see steps 1, 2, and 3 under “Setting up your DVR for Remote 
Connectivity” on page 51.

Connecting to your DVR using Lorex Client 11
1 Insert the software CD that comes included with the system. Open the CD and click DVR 

Software>Lorex Client Software - PC. Follow the on-screen instructions to install Lorex 
Client 11.
• OR, download the Client Software for PC from www.lorextechnology.com.

2 Once installation is finished, double-click the Lorex Client 11 icon ( ) from the desktop. 
The DVR login screen appears.

3 Configure the following:

• IP Address: Enter the DDNS address or local IP address of your DVR. 
• The DDNS address must include the URL Request you created when you registered for 

DDNS, followed by .lorexddns.net. For example, if your URL request is tomsmith, enter 
tomsmith.lorexddns.net. 

• The DVR's local IP address can be obtained by pressing  on the front panel or 
right-clicking and then clicking the Main Menu button ( ) >System>Info (an 
example of a local IP address is 192.168.5.11)

• User Name: Enter the DVR's username. The default user name is admin.
• Password: Enter the DVR's password. By default, the password is left blank.
• Client: Enter the Client Port number of your DVR. By default, this is 9000. 

4 Click Login to access your DVR. Lorex Client 11 connects to your DVR and streams live video 
from your cameras. The interface for Lorex Client 11 is identical to the web client interface 
used when you connect to your DVR using Internet Explorer. For details, see “Remote Viewing 
Interface” on page 63.
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Remote Viewing Interface
Upon login, the Live tab opens. The Remote Viewing interface is the same on PC or Mac.

1 Navigation Tabs: Allows you to access the following tabs: 
• Live: Watch live video.
• Playback: View saved video footage.
• Remote Setting: Configure system and networking options.
• Local setting: Configure where local files are stored on your hard drive.
• Logout: Exits remote viewing.

2 Active Channel List: Displays channels that are currently live. 

1

2

3 4

6

7

5

63



Remote Viewing Interface
3 Viewing options: 

• : Click to open all connected channels.

• : Click to close all connected channels. Note that the system continues to record when 
you close channels remotely.

• : Previous page.

• : Next page.

• : Click to open the selected channel in full screen view.

• : Click to select the desired split-screen viewing options.

4 Split screen viewing: Click the desired viewing mode.

5 Mute: Click to mute audio.

6 Main Screen: Main display screen for live viewing and playback. You can also drag the 
screens to any desired position.

7 PTZ Controls: PTZ (Pan, Tilt, Zoom) control for connected PTZ cameras (not included).

Logging into the System
Log in to your system to begin remotely monitoring the system.

To log in to the DVR:
1 In the User Name field, enter admin.

2 In the Password field, leave the entry blank (default).

NOTE: By default, the user name is admin. The password is left blank.

3 Click Login to connect to the system. 

User name

Password
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Changing Viewing Modes
You can change the number of channels that the system displays simultaneously (i.e. 
Split-screen Mode, Single-channel Mode, etc.)

To change the DVR’s viewing mode:

• Click one of the following: .

• If the controls are not shown, click . 

Taking Screen Shots
The system can take screen shots of a selected channel during live playback.

To take a screen shot of a channel:

1 Click  beside the desired channel to capture an image. 

2 A pop-up window opens on the bottom left corner of the window. Click Preview to view the 
image or Folder to show the image in the save folder.

If you receive an error taking a screen shot:
You may receive an error when taking a screen capture. This is caused by an Internet 
Explorer security setting. 

To reduce the security setting in Internet Explorer:
1 Click on Tools>Internet Options. (In IE9, click the gear icon on the top-right corner).

2 Click the Security tab.

3 De-select Enable Protected Mode.

4 Click Apply to save your settings.

5 Refresh Internet Explorer.
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Recording Video
You can record video footage directly onto your local hard drive. Once the video is in your 
hard drive, you can back up the video footage onto recordable media such as USB memory 
keys and blank CD/DVD media.

To record video:

1 Click  next to the channel that you wish to capture video from.The video will record to 
the default save directory.

2 Click  to stop video recording.

Showing / Hiding Channels 
The Active Channel List is a convenient way to show / hide the cameras that display in the 
main viewing window. 

To show or hide video in the main video window:

1 Click  beside the channel number to show a channel. Click  again to hide the channel.

Click here to show 
or hide video
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Adjusting Sub-menu Options
The sub-menu option gives you quick access functions such as viewing video bit rate, and 
viewing video in its original aspect ratio.

To open the sub-menu:
1 Right-click on a desired channel. A sub-menu 

opens.

2 Click on one of the following:
• Show Bit rate: Displays video bit rate.
• Original Proportions: Displays live video in its 

original proportions.

Changing the Save Directory of Screenshots or Recorded Video
1 Click the Local Setting tab.

2 Click  beside the desired category to browse for a save directory.

3 Select the desired save directory, and then click OK.

4 Click Save to save your changes.

Browse button

Local Setting tab
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Changing the Format of Recorded Video (PC Only)
You can change the format of recorded video saved using Remote Surveillance. This allows 
you to directly backup footage from your DVR as an .avi file. This does not affect the format 
of video files that are backed up locally on the DVR (i.e. using a USB flash drive).

NOTE: This feature is not available via Mac.

1 Click the Local Setting tab.

2 Under File Type, select the file format you would like to use when saving video (264 or avi).

3 (Optional) Under Interval, select the maximum length (in minutes) for video saved on the 
remote computer.

4 Click Save to save your changes.

Local Setting tab

File Type Interval
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Remote Viewing Interface
Configuring PTZ Settings
The system supports remote PTZ controls for compatible PTZ cameras (not included). 

• For details on connecting PTZ cameras to your system, see “Appendix B: Connecting a PTZ 
Camera” on page 106.

To control the PTZ settings on the DVR: 
1 From the Live tab, double-click to select the channel the PTZ camera is connected to.

2 Use the PTZ control panel to control the pan, tilt, zoom, focus, and iris control of the camera.

Direction keys: 
Click to pan and 
tilt the camera

Speed Slider:
Increase or 
decrease the pan 
and tilt speed

Preset: Cruise: 

Video Tab:

Use the Preset tab to configure 
camera presets. Once your PTZ 
camera is in the desired angle, 
press the + button to add the 
setting to the Preset

Use the Cruise tab to
add desired PTZ cruise options

Use the Video tab to configure the 
PTZ camera’s video quality.
Drag the slider to adjust settings

Zoom, Focus, and Iris 
settings

On-screen PTZ Controls:
Click the button to enable / disable 
on-screen PTZ controls. Click 
inside the display area to pan and 
tilt the camera
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Video Playback
Video playback allows you to watch video that has been saved in the DVR’s hard drive.

To playback video:
1 Click the Playback tab.

2 In the calendar window, click the desired month, year, and date.

3 Under the Type drop-down menu, select the desired recording type you wish to search for 
(Continuous, Alarm, or All).

4 Select the channels you wish to search. Check Synchronous playback to play all selected 
channels at the same time.

5 Click the Search button.

6 Click Play to begin playback.

Playback tab

Select month and year

Select date

Select recording type

Select channels

Click Month or Day
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Video Playback Controls

Configuring Display Settings
1 Click the Remote Setting tab, and then click Display>Live.

Playback window

Screen Capture

Play

Pause

Stop

Video slider
Step 
Forward

• Step Forward: Plays video frame by frame. Click the Step Forward button to advance the 
video by 1 frame.

• Video Slider: Drag the slider control the playback speed.
• Download Content: Allows you to download recorded videos to your computer hard drive. To 

download video, click the channel you want to back up and click the Download content button. 
A list of files appears. Select the files you want to back up and click Start Download.

Video content (green)

Download 
content

Drag the line left or 
right to select the 
playback time

Volume

Stop all video
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2 Configure the following:
• Channel: Select the channel you want to modify.
• Name: Enter the channel name if you want to re-name the channel
• Position: Select the position of where the title appears in the channel.
• Covert: Enable or Disable covert recording. Covert recording will hide the channel on the 

DVR’s local display. You will see be able to see the channel when you log in remotely.
• Show Time: Select Enable or Disable to show or hide the time on the DVR’s local display.
• Record Time: Select Enable or Disable to show or hide the record time on the remote display.

3 Click Save to apply your settings.

Configuring Privacy Zone Settings

You can blank out a certain portion of the channel with a black box. 

To configure a privacy zone:
1 Click the Remote Setting tab, and then click Display>Privacy Zone

2 In the Channel drop-down menu, select the channel you wish to configure.

3 Select the Privacy Zone checkbox to enable privacy masking.

4 Drag your mouse cursor over the areas you wish to black out. A red box indicates the area 
that is masked (blocked out). 

• To remove a privacy area, click on the red box, then click the Delete button.

5 Click Save to apply your settings.

ATTENTION: Areas covered by privacy zones are not visible in recordings.

Drag mouse over desired area
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Configuring Recording Parameters
To configure system recording parameters:

1 Click the Remote Setting tab, and then click Record>Rec Parameters.

2 Configure the following:
• Channel: Select the channel you wish to configure.
• Record: Select Enable or Disable to start or stop system recording.
• Pack Duration: Select the duration of each saved file on the system. For example, if you select 

15 minutes, then every file will contain 15 minutes of footage.
• Pre-record: Select whether to enable or disable pre-recording.

3 Click Save to apply your settings.

Configuring the Recording Schedule
To configure the recording schedule:

1 Click the Remote Setting tab, and then click Record>Schedule.

2 Configure the following:
• Channel drop-down menu: Select the channel you wish to configure.
• Week: Select the day of the week you would like to apply the settings to.

The recording schedule is 
arranged as a grid. Each row 
represents a recording type 
(Continuous, Motion, and 
Alarm), and each box 
represents an hour.
73



Remote Viewing Interface
3 Click the recording grid, and select the type and duration of recording.

4 (Optional) Use the top Copy and Copy To drop-down to copy the recording schedule to a 
specific day or all days. Click Copy to copy the schedule.

5 (Optional) Use the bottom Copy and Copy To drop-down to copy the recording schedule to a 
specific channel or all channels. Click Copy to copy the schedule.

6 Click Save to apply your settings.

Configuring System Recording Quality
1 Click the Remote Setting tab, and click Record>MainStream.

2 Configure the following:
• Channel: Select the channel you wish to apply the settings to.
• Resolution: Select the desired recording resolution.
• FPS (Framerate): Select the desired recording frame rate. Note that higher frame rates 

require greater bandwidth consumption during remote viewing.
• Audio: Select whether you want the system to record audio (audio cameras required, not 

included).

3 Click Save to apply your settings.
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Configuring Basic Network Settings
The basic network menu allows you to configure the network protocol type (DHCP or 
Static), UPnP and mobile phone login information.

To configure basic network settings:
1 Click the Remote Setting tab, and click Network.

2 Configure the following under Basic Configuration:
• Type: Select between DHCP or Static. If you select Static, you can edit the IP address, Subnet 

Mask, Gateway, and DNS settings.
• Auto Port Forwarding: Select Enable or Disable to enable or disable the Auto Port Forwarding 

feature.

3 Click Save to apply your settings.

Configuring the System Substream
You can adjust the data streaming rate (also called the SubStream) when you connect to 
the system remotely. If you want to conserve bandwidth, select a lower frame rate and 
bitrate. 

NOTE: Setting your system to stream with a lower frame and bitrate may cause the video to 
appear choppy or slow.

To configure the system’s substream:
1 Click the Remote Setting tab, and click Network>SubStream.
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2 Configure the Substream settings:
• Channel: Select the channel you wish to apply the settings to.
• Resolution: Select the desired recording resolution.
• FPS (Framerate): Select the desired recording frame rate. Note that higher frame rates 

require greater bandwidth consumption during remote viewing.
• Bit Rate: Select the desired video bit rate. 
• Audio: Select whether you want the system to record audio (audio cameras required, not 

included).

3 Click Save to apply your settings.

Configuring Email Notification Settings
To configure email notification settings:

1 Click the Remote Setting tab, and click Network> Email 

2 In the Email drop-down menu, select Default to use the default Lorex email server 
(recommended) or select Custom to use your own custom SMTP email server.

If you want to use Lorex’s email server (recommended):
1 In the Sender Email field, enter the email address of the sender. This can be any email 

address of your choice.

2 In the Receiver Email field, enter the email address you want the DVR to send alarm 
notifications to.

3 In the Interval drop-down menu, enter the Duration the DVR must wait before sending out a 
new notification. 

For example, if you select a 3 minute interval, the DVR will send out email notifications every 
3 minutes until the DVR stops detecting motion / alarm. The DVR will only send out 
notifications when it detects motion/alarm triggers.

4 Click Save to save your settings.

If you select "Enable", and want to use your own email server:
1 Configure the following:
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Remote Viewing Interface
• SSL: Select ON/OFF to enable/disable Secure Socket Layer protocol.
• SMTP Port: Enter your SMTP address.
• SMTP Server: Enter your SMTP Server.
• Sender Email: Enter the sender email address. This can be any address of your choice.
• Sender Password: Enter your email server’s password.
• Receiver Email: Enter the recipient’s email address.
• Interval: Enter the interval the DVR waits before sending a new email notification. 

2 Click Save to save your settings.

Changing the Mobile User Name and Password
You can change the User Name and Password used to connect to the system with a mobile 
device.

To change the mobile user name and password:
1 Click the Remote Setting tab, and click Network>Mobile.

2 Under User Name, enter the desired mobile user name (default: admin).

3 Under Password, enter the desired mobile password (default: 0000).

NOTE: The user name and password applies only to mobile devices connecting to the system.

4 Click Save to apply your settings.

NOTE: The DVR may reboot after the settings are changed.
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Configuring DDNS Settings
To configure DDNS settings:

1 Click the Remote Setting, and click DDNS.

2 Configure the following:
• DDNS: Select Enable or Disable.
• In the Server drop-down menu, select LOREXDDNS.
• Domain Name: Enter your Domain name/URL Request from the confirmation email that was 

sent after you created your DDNS account.
• User name: Enter your DDNS User Name that was emailed to you after DDNS registration.
• Password: Enter your DDNS Device password that was emailed to you after DDNS registration.

3 Click Save to apply your settings.

Configuring Motion Detection Settings
To configure motion settings:

1 Click the Remote Setting, and click Alarm>Motion.

2 Configure the following motion recording parameters:
• Channel: Select the channel you wish to apply the settings to.
• Enable: Select this checkbox to enable motion recording.
• Sensitivity: Select the desired motion detection sensitivity. The greater the value, the greater 

the motion sensitivity.
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• Buzzer: Select OFF to disable the buzzer when the system detects a motion event or select 
the duration of the buzzer after the system detects a motion event.

• Alarm Out: Select the checkbox to trigger connected alarm devices.
• Full Screen: Select the checkbox so that the channel goes into full screen mode when motion 

is detected.
• Enable Record: Select to enable system recording when motion is detected.
• Post Recording: Select the post-recording time after a motion event occurs.
• Record Channel: Select the channels that should record during a motion event.
• Show Message: Select the checkbox to enable the system to display a warning message 

during a motion event.
• Send Email: Select the checkbox for the system to send a email notification during a motion 

event.

3 Drag your mouse cursor in the window to select the desired area to monitor the channel for 
motion.

4 Click Save to apply your settings.

Configuring your System to "Beep" During Motion
You can set your system to "beep" during motion. This is useful to notify you if someone 
enters or exits an area.

To configure the system to "beep" during motion:
1 Click the Remote Setting tab, and click Alarm>Motion.

2 In the Channel drop-down menu, select the channel you wish to configure.

3 Select the Enable checkbox.

4 Beside the Buzzer drop-down menu, select the "beep" duration or select OFF to disable the 
"beep."

5 In the video window, select the area you wish to monitor for motion.

6 Click Save to apply your settings.
Result: The system beeps when it detects motion, and a green "M" icon appears. The green 
"M" icon indicates that the system is only detecting motion, but not recording. To have the 

Click and drag to configure 
motion detection areas
Red: Motion detection enabled
Clear: Motion detection disabled
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system record motion events, enable motion recording in the recording calendar (Remote 
Setting tab>Record>Schedule).

Configuring Alarm Notifications
Configure the settings for alarm devices (not included).

To configure alarm notifications:
1 Click the Remote Setting tab, and click Alarm >Alarm.

2 Configure the following:
• Alarm In: Select the channel that you wish to configure.
• Alarm Type: Select the alarm type N/O (normally open), N/C (normally closed), of select OFF.
• Buzzer: Select the "beep" duration when an event occurs.
• Latch Time: Select the desired latch time when an alarm triggers.
• Show Message: Select the checkbox so that the system displays a warning message during 

an alarm recording.
• Send email: Select the checkbox for the system to send out email alerts during an alarm 

recording.
• Full Screen: Select the checkbox to enable the system to go into Full-screen View when an 

alarm triggers.
• Alarm out: Select the checkbox to enable alarm out devices to activate.
• Enable Record: Select the checkbox to enable system recording when an alarm triggers.
• Post Recording: Select the desired post recording time after an alarm triggers.
• Record Channel: Select the channels that the system should record during an alarm trigger.

3 Click Save to apply your settings.
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Configuring Hard Drive Recording Mode 
To configure the hard drive recording mode:

1 Click the Remote Setting tab, and click Device>HDD.

2 In the Overwrite drop-down menu, select Auto to enable the hard drive to record in loop 
mode. Loop mode allows the system to record continuously. When the hard drive is full, the 
system deletes the oldest footage (first in, first out).

You can also select a desired amount of days or hours the system should retain data. For 
example, if you select 30 days, the hard drive will begin to overwrite itself after 30 days. Note 
that hard drive size determines the duration of hard drive recording.

3 Click Save to apply your settings.

Configuring PTZ Parameters
The system is capable of manipulating PTZ cameras (not included) that are connected to 
the system. Please note that you will need PTZ information from the PTZ manufacturer’s 
users guide. For details on connecting a PTZ camera to your system, see “Appendix B: 
Connecting a PTZ Camera” on page 106.

To configure PTZ settings:
1 Click the Remote Setting tab, and click Device>PTZ.

Overwrite drop-down menu
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2 Configure the following:
• Channel: Select the channel that the PTZ camera connects to.
• Protocol: Select the protocol of the PTZ camera*.
• Baud Rate: Select the baude rate of the PTZ camera*.
• Data Bit: Select the data bit rate of the PTZ camera*.
• Stop Bit: Select the stop bit rate of the PTZ camera*.
• Parity: Select the parity settings of the PTZ camera*.
• Cruise: Select Enable or Disable*.
• Address: Select the address of the PTZ camera*.

*Consult the PTZ camera’s instruction manual for protocol and configuration details

3 Click Save to apply your settings.

Configuring the System Time and Date
To configure the system time and date:

1 Click the Remote Setting tab, and click System>General.

2 Configure the system format and time:
• System Time: Enter the desired system time and date. An on-screen calendar appears when 

you click the date.
• Date Format: Select the desired format the date is displayed in.
• Time Format: Select between 12 hour or 24 hour time formats.

3 Select DST to enable daylight savings time, or NTP to sync the time with a NTP time server.

NOTE: Using the NTP feature requires that your DVR have a constant Internet connection.

Changing the System’s Menu Time Out
To change the system’s time out menu:

1 Click the Remote Setting tab, and click System>General.

2 In the Menu Timeout drop-down menu, select the duration the menu stays on screen before 
disappearing.

3 Click Save to apply your changes.
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Configuring System User Accounts
You can add user accounts on the system.

To configure the user accounts menu:
1 Click the Remote Setting tab, and click System>Users.

2 Configure the following:
• Click the desired user you wish to configure (i.e. user1).
• User name: Enter the desired user name.
• Password: Enter the desired user password.
• Confirm: Re-enter the user password.
• Active: Select Enable or Disable to activate or de-activate a user account.
• Password: Select Enable to require a user password when users log on.

3 Select the menus that the user will have access to.

4 Click Save to apply your settings.

Select the menus users 
will have access to
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Viewing System Information 
To view system information:

1 Click the Remote Setting tab, and click System>Info.

Upgrading System Firmware
To upgrade the system firmware, download the latest firmware from the system’s product 
page at www.lorextechnology.com. 

To upgrade the system firmware:
1 Download and extract the file to your computer’s desktop.

2 Click the Remote Setting tab, and click Advanced>Firmware upgrade.

3 Beside Upgrade File Path, click the browse button ( ). Locate the firmware, and click 
Open.

4 Click Start to begin the firmware upgrade.

5 Follow the on-screen instructions to complete the firmware upgrade. 

NOTE: Your system may have to restart after a firmware upgrade.
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Restoring Default Settings
To restore the system’s system defaults:

1 Click the Remote Setting tab, and click Advanced>Load Default.

2 Select the menus that you wish to restore to factory defaults.

3 Click Save to restore system defaults for the selected items.

Configuring Event Settings
The Event Settings tab allows you to configure how the system behaves when a system 
event occurs (e.g.hard drive error, video loss). This is useful if you want your DVR to notify 
you if there is a potential system problem.

To configure the system event settings:
1 Click the Remote Setting tab, and click Advanced>Events.

2 Configure the following:
• Event Type: Configure the type of event that triggers the system to send an alert.
• Enable: Select Enable to activate the system to notify you if an event occurs.
• Buzzer: Select OFF to enable/disable the system buzzer or select the duration of the system 

buzzer after an event occurs.
• Show Message: Select the checkbox to enable the system to display a warning message when 

an event occurs.
• Send Email: Select the checkbox to enable email notifications. Email notification must be 

enabled.
• Alarm Out: Enable or disable the alarm out panel.
• Latch Time: Configure the system latch time after an event occurs.

3 Click Save to save changes.
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Configuring Auto-Reboot
Auto-reboot allows the system to restart automatically at a set time or date. This improves 
system stability.

To configure Auto Maintain:
1 Click the Remote Setting tab, and click Advance>Maintain.

2 Click the Auto Reboot drop-down menu, and select Enable or Disable to activate or 
deactivate the auto-reboot feature. 

3 Under Reboot, select how often you want the system to reboot and the time you want the 
system to reboot. 

4 Click Save to apply your settings.
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Lorex Player 11: Playing Backed up Video on PC
Lorex Player 11 allows you to view your backed up video files from your DVR on your PC.

NOTE: To view backed up video files on Mac, see “Lorex Player for Mac: Viewing Backed up 
Video on Mac” on page 89.

Minimum System Requirements
• Intel Pentium 4 or above
• Microsoft Windows XP/ Vista / 7
• 256 MB Ram
• 16 MB video memory

Prerequisites
• Back up video files from the DVR to your local hard drive.

Installing Lorex Player 11
1 Insert the software CD that comes included with the system.

2 Click DVR Software>Lorex Player - PC. Follow the on-screen instructions to install Lorex 
Player 11.

Running Lorex Player 11

1 Double-click the Lorex Player 11 ( ) icon on the desktop.

2 Click the Open File to load a single video file. Click the  button next to it to load a folder with 
backed-up videos.

3 Select the file and click Open. 
• If you are opening a folder, click Add.

4 Double-click the file in the list on the right to begin playback.

Open File Open Folder
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Lorex Player 11: Playing Backed up Video on PC
Lorex Player 11 Interface Overview

About the Advanced Config menu
The Advanced Config menu allows you to select where the screen captures are stored.

To open the Advanced Config menu:

1 Click the  button.

2 Click Select to change the snapshot save folder. Then select the folder and click OK.

3 Click OK to save changes.

Click here to open the 
Advanced Config menu

Play

Snapshot button

Add file

Remove file

Delete file

Video Window

Hide/reveal 
playlist

Next
File

Stop

Previous
File

Open FileRewind Fast Forward

Select
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Lorex Player for Mac: Viewing Backed up Video 
on Mac

Lorex Player for Mac allows you to view your backed up video files.

To install Lorex Player Mac:
1 Go to www.lorextechnology.com and search for the model number of your DVR (look at the 

label underneath your DVR for the model number).

2 Navigate to the product page for your DVR model and download LH130 Eco2 Series Player - 
MAC. 

3 Extract the file and double-click the Lorex Mac Player installer (.pkg) file. Follow the 
on-screen instructions to install the software.

Launching Lorex Player Mac:

• Click the Lorex Player Mac icon ( ) in the Dock or in your Applications List in Finder.

Lorex Player Mac interface

Video playlist

Video slider

Hide video playlist
Frame by frame

Fast forward

Rewind

Stop

Play Volume slider

Video window

Load new file

Load folder

Remove selected file

Clear playlist

Looped playback
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Lorex Player for Mac: Viewing Backed up Video on Mac
Loading Individual Video Files

To load files saved onto your hard drive:

1 Click the Load new file button ( ).

2 Browse and select the desired file. Click Open to add the file to the video playlist.

NOTE: The default save directory is in your Home folder/dvr.

3 Double-click the video file in the playlist to begin playback.

Loading Multiple Video Files
You can load an entire folder of video files.

To load multiple video files saved onto your hard drive:

1 Click the Load folder button ( ).

2 Select the desired folder you wish to add to the playlist. Click Open to add all the videos in the 
folder.

3 Double-click the video file in the playlist to begin playback.

Double-click file to begin playback

Double-click file to begin playback
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Mobile Apps: Accessing your DVR Using a Mobile 
Device

You can remotely view camera streams from your DVR on compatible mobile phones and 
tablets.

NOTE: Port forwarding is required before you can connect to your DVR using a mobile device. 
Different features are available on each mobile viewing device and application.

Compatible Devices and Platforms

For the latest device compatibility list, visit www.lorextechnology.com

Before you Begin
You will need the following before you can start viewing on your mobile device:

• Your DVR’s DDNS address: 
Before you can connect with a mobile device, you must complete the setup process for remote 
viewing to obtain your DDNS address and enable DDNS on your DVR. Complete all the steps 
under “Setting up your DVR for Remote Connectivity” on page 51.

• The Mobile Port Number of your DVR:
The Mobile Port (default: 1025) must be port forwarded before you can connect using a mobile 
device. For details on port forwarding, see the Easy Connect manual on the CD or the reference 
guides on www.lorextechnology.com. To find your Mobile port, press PTZ /  on the front 
panel of the DVR to open the System Information window and look under Mobile Port.

• The mobile user ID and password of your DVR:
See the table on the right for the default mobile access user 
ID and password.

Platform Supported Versions and Devices App Name Get App From

iOS iOS v. 4.0 and higher
iPhone/iPod Touch
iPad (1st generation and above)

Lorex Mobile Eco Apple App Store

Android Android v. 1.5 and above Lorex Mobile Eco Google Play Store

BlackBerry 9000, 9700, 9800 Lorex Mobile Eco www.lorextechnology.com

Symbian 3rd and 5th generation models Lorex Mobile Eco www.lorextechnology.com

Windows 
Mobile

v.6.0, 6.5, touch screen models only
Note: Windows Phone 7 is not currently 
supported

Lorex Mobile Eco www.lorextechnology.com

ID PASSWORD

admin 0000

Mobile ID / Password
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Mobile Apps: Accessing your DVR Using a Mobile Device
iPhone / iPad
Use the Lorex Mobile Eco application to connect to 
your DVR on the iPhone or iPad.

NOTE: Resolution is scaled up for the iPad screen.

System requirements
• iOS version 4.0 and above.

NOTE: For the latest device compatibility list, visit www.lorextechnology.com

Prerequisites
• An iTunes account (requires valid credit card number). 

NOTE: Your credit card will not be billed when downloading the Lorex Mobile Eco App. 

Step 1 of 3: Downloading the App
1 In the App Store, search for Lorex Mobile Eco.

2 Touch the Free button (iPhone) or Install button (iPad), and then touch Install to download 
the app.
• Enter your App Store password if required.

• The App installs on your iPhone / iPad and the Lorex Mobile Eco icon ( ) appears in your 
application list.

NOTE: For support on downloading or installing iPhone / iPad apps, consult your iPhone / iPad 
user’s manual or www.apple.com for support.

Step 2 of 3: Configuring Lorex Mobile Eco

1 Touch the Lorex Mobile Eco icon ( ).

2 Touch  to open the Device List menu and then touch Add.

You must port forward the 
mobile port (default: 1025) on 
your router before you can 
connect to your system using 
a mobile device (e.g. iPhone, 
iPad)

!

Add
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Mobile Apps: Accessing your DVR Using a Mobile Device
3 Enter the following:
• Device Name: Enter the name of your system. This can 

be any name of your choice.
• Address: Enter the DDNS address of the DVR (e.g. 

tomsmith.lorexddns.net)1.
• Port: Enter the Mobile Port number of the DVR (by 

default, port 1025).
• User ID: Enter the mobile access user ID of the DVR 

(default: admin).
• Password: Enter the DVR’s mobile access password 

(default: 0000)
• Max Channel: Enter the number of channels of the DVR 

(4, 8 or 16).

4 Touch the OK button and then touch the Back button.

Step 3 of 3: Connecting to your DVR
1 In Quad View, touch the plus button (+).

• If a channel is already selected, touch  then touch + to select another channel.

2 Touch the name of your DVR. Select the channel that you want to display in the selected 
space.

1. Some routers may prevent you from connecting to your DVR using a DDNS address on a local network. If you are 
unable to connect, try disabling WiFi on your mobile device and attempt to connect using the 3G or mobile 
network. If you need to use WiFi, use the DVR’s internal IP address to connect.

+ button
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Mobile Apps: Accessing your DVR Using a Mobile Device
• The selected channel appears in the quad screen display.

TIP: Double-tap the channel to view video in full screen.

3 Repeat steps 1~2 as required for the remaining channels.

Deleting Accounts

• From the Device List, swipe your finger on  beside your device name. The Delete button 
appears. Touch the Delete button to remove the device.

Taking Snapshots
You can take a picture of the selected channel. The 
images save into your Photos directory. 

To take snapshots:

• Touch the camera button ( ).

Touch the name of your DVR. Select the desired channel. The channel appears in quad 

Camera button
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Changing Channels

• Touch the  button repeatedly to display channel 1~4, 5~8, 9~12, 13~16.

Interface Overview
1 Add Device: Touch to add a DVR channel.

2 Channel List: Touch to view channel in full 
screen.

3 Pan & Tilt camera (PTZ only).

4 Zoom in/out (PTZ only).

5 Focus (PTZ only).

6 Iris (PTZ only).

7 Disconnect: Disconnects channel.

8 Snapshot: Takes an image of the channel.

9 Setup: Touch to enter the setup menu.

10 Channel button: Touch to change the quad 
channel numbers (Ch 1~4, 5~8, 9~16).

11 System info: Display system information.

Touch here to change quad view 
channels Channel 5~8
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Android
Use the Lorex Mobile Eco application to connect to 
your DVR on an Android smartphone or tablet.

NOTE: The instructions below may differ depending on 
the model of your Android device.

System requirements
• Android v. 1.5 and above.

NOTE: For the latest device compatibility list, visit www.lorextechnology.com

Step 1 of 2: Downloading the App

NOTE: For support on downloading or installing Android apps, consult your Android device’s 
user’s manual or the manufacturer’s support site.

1 Touch the Google Play Store icon ( ) in your Applications list.

2 Press the search button ( ).

3 Enter Lorex Mobile Eco and then press the search button again ( ).

4 Touch Lorex Mobile Eco. Then touch Install to download and install the app. Wait for the app 
to install.

Step 2 of 2: Configuring and Connecting to Lorex Mobile Eco

1 Open the Lorex Mobile Eco ( ) app from the applications list.

2 Touch the Settings button ( ) to open the Device List and touch Add.

You must port forward the 
mobile port (default: 1025) 
on your router before you can 
connect to your system using 
a mobile device (e.g. 
Samsung Galaxy S, HTC 
Incredible S)

!

Settings

Touch Add
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3 Configure the following:
• DVR Title: Enter a name for your DVR of your choice.
• Server: Enter the DDNS address of the DVR (e.g. 

tomsmith.lorexddns.net)1.
• Port: Enter the DVR’s Mobile Port number (default: 

1025).
• User Name: Enter the mobile access ID (default: admin).
• Password: Enter the DVR password (by default: 0000).
• Max Channel: Enter the number of total channels your 

DVR can support (e.g. 4, 8, or 16).

4 Touch OK. Touch the Back button.

5 In Quad View, touch +. Touch the name of your DVR and 
select the channel you would like to display in the space 
in Quad view.

1. Some routers may prevent you from connecting to your DVR using a DDNS address on a local network. If you are 
unable to connect, try disabling WiFi on your mobile device and attempt to connect using the 3G or mobile 
network. If you need to use WiFi, use the DVR’s internal IP address to connect.

Touch +

Touch the name 
of your DVR

Then, touch the 
channel you want 
to add

Touch the arrow to 
change your DVR 
details or delete a DVR

Play Settings

Screenshot

PTZ Controls 
(PTZ camera 
required, not 
included)

Previous 4 channels

Next 4 channels

Viewing Controls
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Mobile Apps: Accessing your DVR Using a Mobile Device
BlackBerry
Use the Lorex Mobile Eco application to connect to 
your DVR on a Blackberry smartphone.

Prerequisites:
• Blackberry 9000, 9700, 9800
• Blackberry Desktop Software
• Obtain your Blackberry’s APN (Access Point Name) 

from your service provider, and enable APN on your Blackberry 

NOTE: For the latest device compatibility list, visit www.lorextechnology.com

Step 1 of 2: Downloading and Installing the App

NOTE: For support on downloading or installing BlackBerry apps, consult your BlackBerry’s 
user’s manual or www.blackberry.com for support.

1 Go to www.lorextechnology.com, and search for the model number of your DVR (look at the 
label underneath the DVR for the model number). 

2 Navigate to the product page for your model and download the appropriate app for the 
BlackBerry. Extract the contents of the .zip file to a folder.

3 Connect the Blackberry to your computer using a USB cable.

4 Open Blackberry Desktop Software.

5 Click Applications. Wait for the applications list to populate.

You must port forward the 
mobile port (default: 1025) 
on your router before you can 
connect to your system using 
a mobile device (e.g. 
Blackberry 9000)

!

Applications

Blackberry Desktop Software
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Mobile Apps: Accessing your DVR Using a Mobile Device
6 Click Import Files.

7 Locate the folder where you extracted the install files. Select the install file (ends in an .alx 
extension) and then click Open to install the file.

8 Click Apply to complete the installation. 
Wait for the installation to complete.

Step 2 of 2: Configuring Lorex Mobile Eco

1 Locate the app in your BlackBerry and open Lorex Mobile Eco ( ).

2 In the Setting window, enter the following:
• Title: The name of your system. This can be any name of your choice.
• Address: Enter the DDNS address of the DVR (e.g. tomsmith.lorexddns.net)1.
• Port: Enter the Mobile Port number of the DVR (by default, port 1025).
• No. of CHs: Select the number of channels of your DVR.
• User ID: Enter the mobile access user ID of the DVR (by default: admin).
• Password: Enter the DVR’s mobile access password (by default: 0000):

3 Click the Login button to log in to the DVR.

1. Some routers may prevent you from connecting to your DVR using a DDNS address on a local network. If you are 
unable to connect, try disabling WiFi on your mobile device and attempt to connect using the 3G or mobile 
network. If you need to use WiFi, use the DVR’s internal IP address to connect.

Import Files

Apply

Select 3G or WiFi

Select number of channels

My DVR
tomsmith.lorexddns.net
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Mobile Apps: Accessing your DVR Using a Mobile Device
Connecting to the DVR through the Device List
1 In the Device List, select and open the name of the account you created.

Controls

Enabling APN on Your Blackberry
In order for Mobile View to run, you must enable APN (Access Point Name) on your 
Blackberry. Contact your service provider for your Blackberry’s APN name.

NOTE: The instructions below may differ based on the model of your Blackberry 
smartphone. For support related to enabling APN, please contact your smartphone 
service provider.

Play 

Snapshot 

Settings PTZ controls

Adjust channel view:

Click repeatedly to view channel 9 or greater. 
Click repeatedly to view the PTZ controls.

Select channel you wish to view

Full 
Screen
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Mobile Apps: Accessing your DVR Using a Mobile Device
To enable APN:

1 Press the Menu button ( ) and open the Options menu.

2 Select Advanced Options > TCP/IP

3 Select the checkbox beside APN Settings to enable APN.

4 Beside APN, enter your APN. You must obtain the APN from your local service provider.

5 Exit to save your settings.

Options folder

Opening the Options folder

Opening APN settings menu

APN address

Example

Enabling APN settings
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Windows Mobile
System requirements
• v. 6.0, 6.5 (touch screen models only)
• Windows Phone 7 is not currently supported

NOTE: For the latest device compatibility list, visit 
www.lorextechnology.com

Step 1 of 2: Downloading the App
1 Go to www.lorextechnology.com, and search for the model number of your DVR (look at the 

label underneath your DVR for the model number). 

2 Navigate to the product page for your model and download the appropriate app for Windows 
Mobile devices.

3 Download and install the app on your Windows Mobile phone.
For support on downloading or installing Windows Mobile apps, consult your Windows 
Mobile’s user’s manual, or www.microsoft.com for support.

Step 2 of 2: Configuring and Connecting to Lorex Mobile Eco

1 Open the Lorex Mobile Eco ( ) app on your phone.

2 Click the Setting button.

3 Configure the following:
• User Name: Enter the mobile access user ID of the DVR (default: admin).
• Password: Enter the mobile access password (by default: 0000).
• IP: Enter the DDNS address of the DVR (e.g. tomsmith.lorexddns.net)1.

1. Some routers may prevent you from connecting to your DVR using a DDNS address on a local network. If you are 
unable to connect, try disabling WiFi on your mobile device and attempt to connect using the 3G or mobile 
network. If you need to use WiFi, use the DVR’s internal IP address to connect.

You must port forward the 
mobile port (default: 1025) 
on your router before you can 
connect to your system using 
a mobile device (e.g. Windows 
Mobile Smartphone)

!

Setting
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Mobile Apps: Accessing your DVR Using a Mobile Device
• Port: Enter the DVR’s Mobile Port number (by default, port 1025).

4 Select the Auto Connect checkbox and then click Ok. 

5 From the Server window, select the DVR account you created. Click OK to connect to the DVR.

Symbian OS
System requirements
• 3rd and 5th generation models

NOTE: For the latest device compatibility list, visit 
www.lorextechnology.com

Step 1 of 2: Downloading the App
1 Go to www.lorextechnology.com, and search for the model number of your DVR (look at the 

label underneath your DVR for the model number). 

2 Navigate to the product page for your model and download the appropriate app for Symbian 
devices.

3 Download and install the app on your Symbian-based phone.
• For support on downloading or installing Symbian OS apps, consult your Symbian device’s 

user’s manual or the manufacturer’s support site.

Auto Connect check box

Select the name of your DVR

You must port forward the 
mobile port (default: 1025) 
on your router before you can 
connect to your system using 
a mobile device (e.g.Symbian 
Smartphone)

!
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Mobile Apps: Accessing your DVR Using a Mobile Device
Step 2 of 2: Configuring and Connecting to Lorex Mobile Eco

1 Open the Lorex Mobile Eco ( ) app on your phone.

2 Click the Settings button ( ).

3 Configure the following:

• IP: Enter the DDNS address of the DVR (i.e tomsmith.lorexddns.net)1.
• Port: Enter the DVR’s Mobile Port number (by default, port 1025).
• User Name: Enter the DVR’s user name (by default: admin)
• Password: Enter the DVR password (by default: 0000)
• Alias: Enter a DVR name of your choice

4 Save your settings. From the main viewing window, press the play button to connect to the 
DVR.

1. Some routers may prevent you from connecting to your DVR using a DDNS address on a local network. If you are 
unable to connect, try disabling WiFi on your mobile device and attempt to connect using the 3G or mobile 
network. If you need to use WiFi, use the DVR’s internal IP address to connect.

SettingsPlay
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Appendix A: System Specifications

As our products are subject to continuous improvement, Lorex Technology Inc. and its 
subsidiaries reserve the right to modify product design, specifications, and prices without 
notice and without incurring any obligation. E&OE

www.lorextechnology.com

SYSTEM 

Operating System Linux (embedded)

Pentaplex Simultaneous View, Record, Playback, Backup & Remote Monitoring

Number of Channels 4/8/16 Channel

Inputs/Outputs 

Video IN 4/8/16 x 1Vp-p, CVBS, 75ohms, BNC

Video OUT 2 x BNC

VGA OUT 4 ch: Yes     
8 ch: Yes      
16 ch: VGA port works only when HMDI is not used 

HDMI Yes

Audio IN 4 Line in(RCA), G.711(4&8 ch), 16 Line in(BNC), G.711(16 ch)

Audio OUT 2 line out(RCA), G.711(4&8 ch), 2 line out(BNC), G.711(16 ch)

USB Port 2 at the back

Alarm IN 4 ch: 4 ch IN     
8 ch: 4 ch IN      
16 ch: 16 ch IN 

Alarm OUT 1 ch OUT

Video Output Resolution 800x600, 1024x768, 1280x1024, 1440x900, HDMI

PTZ control RS-485 Pelco D & P Protocol

Display 

Live Display 4 ch: 1,4     
8 ch: 1, 4, 8     
16 ch: 1, 4, 9, 16

Live Display Speed 120 (4 ch)/ 240 (8 ch)/ 480 (16 ch) NTSC   
100 (4 ch)/ 200 (8 ch)/ 400 (16 ch) PAL

OSD  ON/OFF

System Navigation USB Mouse, IR Remote Controller, Front Panel

Motion Area Setting Adjustable grid (10 x15) NTSC    
Adjustable grid (12 x15) PAL

Sensitivity levels 8

Firmware Upgrade Via USB device and Network

User Authority By user group

Time Synchronization Auto time sync by NTP server

RECORDING 

Video Compression H.264 

Audio Compression G.711

Recording Resolution NTSC: 360x240 (CIF), 720x240 (HD1), 720x480 (D1)   
PAL: 360x288 (CIF), 720x288 (HD1), 720x576 (D1)

Recording Speed:  4 ch: 120/100 (NTSC/PAL) @ CIF, HD1, 60/50 (NTSC/PAL) @ D1  
8 ch: 240/200 (NTSC/PAL) @ CIF, 120/100(NTSC/PAL) @ HDI,  
60/50 (NTSC/PAL) @ D1    
16 ch: 480/400 (NTSC/PAL) @ CIF, 240/120(NTSC/PAL) @  
HDI, 120/100 (NTSC/PAL) @ DI

Recording Resolution Setting Per camera for different resolutions (CIF/2CIF/D1) 

Recording Quality Control 3 levels 

Recording Schedule By hour, by day, by recording mode, by alarm, by ch

Pre Recording Max. 10 Secs

Post Recording Max. 5 Minutes

Reliability Watch-Dog, Auto-recovery after power failure 

Covert Video Yes

PLAYBACK 

Playback Channel 1~4  Adjustable(4 ch), 1~8 Adjustable (8 ch), 1~16  
Adjustable (16 ch)

Playback Speed Variable Max 16x

Playback Players Backup Player

Search By time & event

Log Search Up to 10,00,000 lines for alarm activated, motion  
detected, configuration changes, connects/disconnects  
and video loss.

Audio Play Yes

STORAGE & ARCHIVE 

Storage 4 & 8 ch: Up to 1 HDD’s (SATA)   
16 ch: Up to 2 HDD’s (SATA) 

Maximum Capacity  4 & 8 ch: Up to 2TB   
16 ch: Up to 2 x 1 TB 

Backup Media USB Flash Drive & HDD

Backup File Format H.264 file (AVI generator included)

CONNECTIVITY 

Easy Connect  Lorex Auto Port Forward Wizard

Supported Operating Systems 4/8/16 ch: Windows™ XP, Vista, 7   
4/8/16 ch: Mac OSX Snow Leopard 10.6 or above  

Browsers Internet Explorer & Safari 5.1

Email notification Text with snapshot

Instant Smart Phone Compatibility† Smart Phone & Tablet Compatibility: iPad™, 
  iPhone™, BlackBerry (supported model numbers:  
 9000, 9700, 9800), Android (version 1.5 &  
 above), Windows Mobile (6.0, 6.5), Symbian  
 3rd & 5th generation phones.

DDNS Free Lorex DDNS

System Configuration Full setup configuration over network

Ports Programmable by User

Network Protocol TCP/IP / DHCP / UDP / DDNS / PPPoE

Network Interface 10/100-Base-TX, RJ-45 

Network Speed Control 48Kb ~ 8MB/sec.

GENERAL 

Power Consumption 4 & 8 ch: Approx. 10 watts    
 16 ch: Approx. 15 watts 

Supply Voltage 4 & 8 ch: 100VAC-240VAC, 12VDC , 3A, 50/60Hz 
 16 ch: 100VAC-240VAC, 12VDC , 5A, 50/60Hz

Unit Dimensions 4 & 8 ch:11.81”/300mm x 8.66”/220mm x  
(W x D x H) 1.97”/50mm           
                                             16 ch:14.96” /380mm x13.39”/340mm x  
 1.97”/50mm 

Unit Weight (KGs) 4 & 8 ch: 1.7 kg/3.75 Lbs   
 16 ch: 3 kg/6.6 Lbs

Operating temperature 32° ~ 104° F / 0° ~ 40° C

Humidity 10 ~ 90% NC

DVR:

1. Recording time may vary based on recording resolution & quality, lighting 
conditions and movement in the scene.

2. Requires a high speed internet connection and a router (not included).
† Smart Phone & Tablet Compatibility: iPad™, iPhone™, BlackBerry (supported
model numbers: 9000, 9700, 9800), Android (version 1.5 & above), Windows 
Mobile (6.0, 6.5), Symbian 3rd & 5th generation phones. Mobile phone data 
plan is required (not included). Router port forwarding required. 

For the latest compatibility list check www.lorextechnology.com as new models 
become available in the market. 

All trademarks belong to their respective owners. No 
claim is made to the exclusive right to use the trademarks listed, other than the 
trademarks owned by Lorex Technology Inc. We reserve the right to change 
models, configurations or specifications without notice or liability. Product may not 
be exactly as shown. Images are simulated.

DISCLAIMERS:

LH130 ECO2 SERIES
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Appendix B: Connecting a PTZ Camera
You can connect RS-485 PTZ cameras (not included) to the RS485 ports on the rear panel.

To connect a PTZ camera to the system:
1 Connect the Transmit+ (TX+) Cable to the + side of the RS485 port on the rear panel. 

2 Connect the Transmit- (TX-) Cable to the - side of the RS485 port on the rear panel.

3 Connect the video cable to a BNC port.

Configuring PTZ Settings
Before you can use the PTZ controls, you must enter your camera’s PTZ protocol details 
into the DVR.

Prerequisite:
• Obtain the PTZ protocol details for your camera. Check your camera’s instruction manual for 

details.

To enter PTZ camera settings in the DVR:

1 Right-click to open the Menu Bar and click the Main Menu button ( ).

2 Click Device and select the PTZ tab.

BNC

TX+

TX-

8-channel model shown

Alarm block on 16-channel model

NOTE: Use a flat-head screwdriver 
to loosen the screws above the 
RS485 ports, then insert the cables 
and tighten the screws to secure
106



Appendix B: Connecting a PTZ Camera
3 Configure the following according to your PTZ 
camera’s specifications:
• Channel: Select the channel the PTZ camera 

is connected to.
• Protocol: Select from Pelco-D or Pelco-P
• Baud rate: Select the PTZ camera’s baud rate
• Data Bit: Select from 5~8 data bits.
• Stop Bit: Select from 1 or 2 stop bits.
• Parity: Select from None, Odd, Even, Mark 

or Space.
• Cruise: Select Enable to enable PTZ cruise.
• Address: Enter the PTZ camera’s address
Use the Copy To drop-down menu to copy the 
PTZ settings to multiple channels.

4 Click Apply to save your settings.

Using the PTZ Menu (Local DVR)
To control the PTZ camera locally on your DVR:

1 Select the channel that the PTZ camera is connected to.

2 Press and hold the PTZ button on the front panel of the system for 6 seconds. Enter the 
system password. The PTZ menu opens.

3 Use the on-screen PTZ controls to control the camera.

PTZ button
Press & hold 6 seconds

Channel: 
Select the channel the PTZ 
camera connects to.

Click the + and - symbols to 
adjust the camera Zoom, 
Focus and Iris settings

Direction keys: 
Click to pan and tilt the camera

Speed Slider:
Increase or decrease the pan and tilt 
speed

Camera Pre-set 
controls
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PTZ Presets and PTZ Cruise
You can set preset positions for your PTZ cameras. You can also use PTZ cruise to have the 
camera automatically cycle through presets.

Setting PTZ Presets
1 Using the PTZ controls, move the camera into position.

2 (Optional) In the Time field, select the number of seconds the camera will remain in that 
position during PTZ cruise before going to the next position.

3 Click Set to set the preset. The Total and No. field will automatically increase. The Total field 
shows you the total number of created presets, and the No. field shows you the number of the 
preset you are currently creating.

4 Complete the steps above to create additional presets as needed. Press Save when you are 
finished to save all created presets.

Selecting PTZ Presets
1 In the No. field, select the number of the preset you would like to select.

2 Click Go to to go to the preset.

Deleting PTZ Presets
1 In the No. field, select the number of the preset you would like to delete.

2 Click Clear to delete the preset and click Save to save your changes.

Starting / Stopping PTZ Cruise
When PTZ cruise is enabled, the camera will cycle through saved presets. You must set and 
save presets to use PTZ cruise.

To start / stop PTZ cruise:

1 Right-click to open the Menu Bar and click the Start Cruise button ( ). Enter the system 
password. The camera will cycle through PTZ presets.

• To stop the PTZ cruise, right-click to open the Menu Bar and click the Stop Cruise button ( ). 
Enter the system password.

Save Presets

Clear Preset

Set Preset

Go To Preset

Total Number 
of presets

Preset number

Time shown 
before changing
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Appendix C: Connecting Additional External Monitors
Use the Video Output ports (BNC) on the rear panel of the system to connect an external 
monitor(s). This is useful if you need to monitor the system from a second location (e.g. a 
back office). 

On the 4/8-channel models, monitors connected to the Video Output ports mirror the 
entire screen of your system and show the mouse cursor and system menus. 

On the 16-channel model, connect external monitors to either the Main or Spot port. 

• The Spot port automatically shows channels in Sequence View. It can also be configured to 
show 1 channel in full-screen or multiple channels in split-screen.

• The Main port can be used to connect an additional monitor for observation, or to use a BNC 
monitor or TV (using a BNC to RCA adapter, not included) to control the DVR. You can press 
0 on the remote control three times to switch the mouse and system interface between the 
monitor connected to the VGA/HDMI port and the monitor connected to the Main port.

EXTERNAL MONITORS 
(Not Included)

(Not Included)

PRIMARY MONITOR/TV 
(VGA/HDMI)

VGA or HDMI cable

BNC cable

BNC to RCA adapter

To connect the DVR to a 
television using RCA cables, 
connect a BNC to RCA 
adapter (not included) to the 
VIDEO OUTPUT port.

 BNC cable

8-channel model shown

16-channel model only:
Main: Primary or 
Secondary Display
Spot: Sequence Mode
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Configuring the Spot Monitor for Full-Screen or Split-Screen 
(16-Channel Models Only)

By default, a monitor connected to the Spot port automatically shows channels in 
Sequence View.

To configure the Spot monitor to show channels in split-screen:

1 Right-click to open the Menu Bar and click the Main Menu button ( ).

2 Click Display and select the Output tab.

3 Under Video Output, select Spot-Out to configure settings for the monitor connected to Spot.

4 Under View Setup, select Enable. This lets you select and arrange the channels you want to 
show on the screen.

5 Under View Mode, select Single to show 1 channel in full-screen, Quarter to show 
4-channels in split-screen, or Ninth to show 9-channels in split-screen.

6 Click Spot Sequence. A menu appears that allows you to select the arrangement of channels 
you would like to show on the Spot monitor.

7 Click the drop-down menus to select which channels you would like to show on the screen 
and the arrangement of channels.

8 Click Apply to save changes. Click Ok. Right-click repeatedly to exit all menus and return to 
live viewing.

Select Enable

Select Spot-Out

Click Spot Sequence

Select the channels that will 
be shown on the screen and 
the arrangement of channels
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Appendix D: Recording Audio
The system can also record audio for up to 4 channels (4/8-channel models) or 16 channels 
(16-channel model). You must have audio-capable cameras (not included) or self-powered 
microphones (not included) in order to record audio on the system.

To enable audio recording:
1 Connect the BNC video cable from the camera to one of the BNC Video INPUT ports on the 

rear panel of the DVR between 1 and 4 (4/8-channel models) or any Video Input port 
(16-channel). For example, connect the camera to Video INPUT port 1.

2 Connect the RCA audio cable from the camera to the corresponding Audio INPUT. Following 
the example in step 1, you would connect the cable to Audio INPUT port 1.

Connect an RCA audio cable from the camera into the 
corresponding Audio INPUT port

8-channel model shown

Connecting Audio Cameras 4/8-Channel Models

Audio IN channels 1~4 Audio IN channels 5~16

Audio harness:
Connect the audio harness into the AUDIO 
IN (CH5-CH16) port. The ends of the audio 
harness requires a BNC to RCA adapter to 
connect RCA audio cameras.

Connect a BNC to RCA connector 
(not included) to connect RCA 
devices to BNC ports.

Connecting Audio Cameras 16-Channel Models
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Appendix D: Recording Audio
• 16-channel model only: BNC to RCA adapters (not included) are required to connect RCA 
devices to BNC ports. Use the included Audio Harness cable to connect Audio for channels 
5~16.

3 Right-click to open the Menu Bar and click the Main Menu button ( ).

4 Click Record and select the MainStream tab.

5 Ensure the Audio checkbox is checked next to the channel the audio-enabled camera is 
connected to.

6 Click Apply to save your changes.

Check Audio to enable audio 
recording on each channel
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Appendix E: Replacing the Hard Drive
The system comes with a pre-installed 3.5" SATA hard drive. You can expand the 4/
8-channel models with a replacement single hard drive up to 2 terabyte (TB). The 
16-channel model has two hard drive bays and can be expanded with a maximum of two 1 
terabyte (TB) hard drives (for a maximum storage space of 2TB).

NOTE: It is recommended to use surveillance or security-certified hard drives, which are 
designed to be reliable over long periods of time while recording 24/7. Security-certified 
hard drives are available at www.lorextechnology.com

Removing the Hard Drive

To remove the hard drive:
1 Remove the screw from each side panel and rear panel (x3) of the cover.

NOTE: The 16-channel model has 4 rear panel screws and 2 screws on each side panel.

2 Gently slide the cover away from the rear panel and lift off. Be careful of sharp edges.

3 Disconnect the power and data cables.

4 Remove the screws from the mounting brackets.

Make sure that the power cable has been disconnected before changing the 
hard drive.
113

www.lorexcctv.com


Appendix E: Replacing the Hard Drive
5 Gently remove the hard drive from the housing.

Replacing the Hard Drive
To replace the hard drive:

1 Place the new drive in the housing. Note that the hard drive must be installed upside down on 
the 4/8-channel models only.

2 Reconnect the power and data cables. Each cable can only be connected one way.

3 Replace the cover, tucking the lip of the cover at the front panel.

4 Replace the screws on the side and rear panels of the cover.

Formatting the Hard Drive
If you replace the pre-installed hard drive, it must be formatted in order to function 
properly with the system.

To format the hard disk:

1 Right-click to open the Menu Bar and click the Main Menu button ( ). 

2 Click Device.

3 Click the checkbox under Select to choose the drive you wish to reformat.

4 Click Format HDD. 

5 When the warning window appears, click OK. Wait for the system to format the hard drive.

NOTE: You will notice that the size of the HDD and the free space are not the same. The system 
uses a portion of the disk space for the operating system and initialization. This is 
common in all security DVRs as well as computer hard drives.

ATTENTION: Formatting the HDD erases all data on the hard disk. 
This step cannot be undone.

Select checkbox
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Troubleshooting
When a malfunction occurs, it may not be serious and can be corrected easily. The following 
describes the most common problems and solutions. Please refer to the following before 
calling Lorex Technical Support:

Error Possible Causes Solutions

• System is not 
receiving power, or is 
not powering up

• Cable from power adapter is 
loose or is unplugged

• Confirm that all cables are connected correctly
• Confirm that the power adapter is securely connected 
to the back of the unit

• Power switch is set to OFF (•) 
position

• Confirm that the power switch is in the ON (I) position.

• Cables are connected, but 
system is not receiving sufficient 
power

• Confirm that the system is powered on (LED indicators 
on the front should be ON)

• If the unit is connected through a power bar or surge 
protector, try bypassing the bar and connecting the 
power directly to the wall outlet
• Confirm that there is power at the outlet:

• Connect the power cable to another outlet
• Test the outlet with another device (such as a lamp 

or phone charger)

• Remote control is 
not detected by the 
system

• Battery in the remote control is 
drained

• Install two fresh AAA alkaline batteries in the remote 
control

• There are no batteries in the 
remote control

• Hard drive is not 
detected by the 
system

• Hard drive cables are loose or 
not properly connected

• Remove the housing and check that hard drive cables 
are firmly connected

• There is no hard drive in the 
system

• Open the housing and install a 3.5" SATA hard drive. 
Make sure to format the drive after installing. For 
details, see “Configuring Hard Drive settings” on 
page 46.

• Hard drive is full 
(0%) and the unit is 
no longer recording

• Overwrite is not enabled • From the Main Menu, select DEVICE>HDD>. Select 
Auto under Overwrite.
115



Troubleshooting
Troubleshooting (Continued)

Error Possible Causes Solutions

• There is no picture 
on monitor/TV after 
connecting it to the 
DVR

• Monitor/TV not detected by DVR • Power off the monitor/TV and DVR. Power on the 
monitor/TV, and then power on the DVR

• Input channel for DVR not 
selected on monitor/TV

• On the monitor/TV, select the input channel the DVR is 
connected to

• Video cable is loose or has 
become disconnected

• Check the video cable connection to the DVR and 
monitor/TV

• Video-out resolution has been 
set to the incorrect setting

• Press and hold the  button on the front panel of the 
DVR until the DVR restarts. The DVR will reset to the 
default resolution (1024x768)

• Mouse not detected 
by system

• Mouse cable is not firmly 
connected to the system

• Firmly connect the mouse cable to the USB Mouse 
port on the front panel

• Mouse is not connected to the 
system

• System needs to be reset • Power off the system (disconnect power cable). Firmly 
connect a USB mouse to the USB Mouse port on the 
front panel of the system. Reconnect the power cable to 
the DC 12V port on the rear panel.

• There is no picture 
on selected channels 
/ camera picture is 
not being displayed

• Camera cables are loose or 
have become disconnected

• Check the camera video cable and connections 
• Disconnect and reconnect the cable at the system and 
at the camera
• Try moving the camera to another channel or use 
another cable

• The image on the 
DVR appears, but 
does not have sound

• Audio cables are loose or have 
been disconnected

• Check the AUDIO Input connections to the DVR

• Volume on external speakers 
(not included) is low or off

• Increase volume on external speakers (not included)

• The system beeps 
at startup

• The beep at startup is normal

• The system beeps 
during motion 
detection

• Motion detection is enabled and 
the alarm buzzer is activated

• Open the Main Menu and click System>Motion. In the 
Buzzer drop-down, select Off. Click pply

• I am not receiving 
email notifications

• Email notification is disabled • Ensure you have configured email notification. For 
details, see “Setting up Email Notification” on page 42

• Default setting is disabled, but 
you have not entered your own 
SMTP information

• If you want to use your own SMTP server, deselect the 
Default box, and enter your SMTP Server address, Port, 
User name, and Password in the respective fields
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Troubleshooting Remote Connections

Error Possible Causes Solutions

• Cannot connect to the 
DVR on a local network

• DVR not connected to router • Connect an Ethernet cable from the DVR LAN port 
to your router, and then reset the DVR using the 
power switch

• DVR and computer not on same 
network

• Ensure your DVR and computer are connected to 
the same router

• If your computer is using a WiFi network, try 
connecting it to the router using an Ethernet cable

• Cannot connect to the 
DVR over the Internet

• Ports not forwarded • Port Forward the HTTP port (default: 80), Client 
Port (default: 9000), and Mobile Port (default: 1025) 
on your router. For details on port forwarding, see 
the Easy Connect manual on the CD or the 
reference guides on www.lorextechnology.com

• DDNS account not created • Follow the instructions under “Step 2 of 4: Create 
a DDNS Account” on page 56

• DDNS not enabled on DVR • Follow the instructions under “Step 3 of 4: Enable 
DDNS on the DVR” on page 60

• DDNS address not entered 
correctly

• In Internet Explorer or Safari, enter http://, the 
DDNS domain name from the confirmation email in 
full, and then colon and HTTP port (for example, 
http://tomsmith.lorexddns.net:80)

• Cannot connect to the 
DVR using a mobile device

• DVR has not been configured 
for Internet connection

• Ensure you have followed all the steps in “Setting 
up your DVR for Remote Connectivity” on page 51. 
See above to troubleshoot remote connections

• Mobile Port has not been 
forwarded

• Forward the Mobile Port (default: 1025) on your 
router. For details on port forwarding, see the Easy 
Connect manual on the CD or the reference guides 
on www.lorextechnology.com

• IP address used from outside 
internal network

• Use the DDNS address to connect to the DVR 
using a mobile application

• Router is blocking DDNS 
connection from internal network

• Turn off WiFi connection and attempt to connect 
using 3G or mobile network
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